
Movavi Video Suite 20
 

 
What do you need help with today?

Removing trial restrictions
Activate Movavi Video Suite save videos without a watermark and remove all restrictions.
Recording screen

Capture any fragment of your screen or the full desktop.
Editing video

Create a movie from videos and photos
Capturing video

Record video from a camera.
Cutting video

Cut video files into multiple files or cut out scenes.
 

Need more help?
Write to us at support@movavi.com

Or click here to open live chat.

mailto:support@movavi.com
https://chatserver.comm100.com/ChatWindow.aspx?planId=1190&visitType=1&byHref=1&partnerId=-1&siteid=27345
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Activating Video Suite
Buy Activation Key
Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via email.

 
Open the Activation window
Open the Movavi Video Suite launcher and click the Activate button.

Activate the program
Enter your activation key and click Activate.

Activating without Internet access
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

 
Step 2:
•  Open the Movavi Video Suite launcher and click the Activate button.
•  Or launch any application in Movavi Video Suite, then open the Help menu and select Activate Software.

http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
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Step 3: Enter your activation key and select the Activate offline option. Then, click Activate.

Step 4: In the next window, click Copy and transfer this information to a computer or device with an Internet connection.

Step 5: When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You
should receive a reply within an hour. Copy the registration key from the reply and transfer it to the computer with Movavi Video Suite.

 

mailto:reg@movavi.com
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Step 6: Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you
used before. Then, paste the registration key into the box and click Activate.

Managing subscription
If your subscription has expired, you need to renew it to continue using the program.

To renew your subscription, click the Renew Subscription button. A web page will open, where you can buy the license. Once you've made a
purchase and received the activation key in an email, copy the key and paste it into the program window. Then click Activate.
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Have troubles renewing the subscription?
•  If you haven't received an e-mail with the activation key within an hour, check the Spam folder in your email box.
•  Contact our support team. Our experts will help you figure out and solve any of the related problems.

Getting an activation key
To activate Movavi Video Suite, you will need an activation key. You can buy an activation key from our official website or from any of our
partners, and it will be delivered to you via e-mail.
 
1. On the Movavi Video Suite launcher, click Buy or use the button below.
Click the Help menu if you are already in the process or recording or editing.

2. On the purchase page, click the Buy Now button next to the type of license that you need.
•  If you're a home user, choose the Personal License.
•  If you're planning to use Movavi Video Suite for work, business, or government organizations, choose the Business License.
 
3. Fill in your billing information and enter a valid e-mail address. IMPORTANT! We will send the activation key to this e-mail address, so
please make sure it is entered correctly.
 
4. After you've completed your payment and your request has been processed, you will receive a confirmation e-mail from
support@movavi.com with your activation key.

If you haven't received your activation key:
•  Check the Spam folder of your mailbox
•  Contact support

Trial limitations
When you first start your copy of Movavi Video Suite, it will be running in LIMITED TRIAL MODE. In trial mode, you can try out all of the main
features, but the following trial restrictions will apply:
 
TRIAL VERSION FULL VERSION

 Movavi Video Suite will stop working after 7 days  Lifetime license

 A watermark with the words ' trial version' will be added to all
output videos

 No annoying watermarks

 System sound recording is disabled  System sound recording

 Taking screenshots is disabled  Taking and editing screenshots

 You can only convert half of each audio file and half of each video
if you use SuperSpeed mode

 Unlimited video and audio conversion

   Free updates
   Discounts on other Movavi products and upgrades
 
 
 

Launcher
The interface of Movavi Video Suite is divided into three main regions: the features menu, the Favorites board and Spotlight.
 
The Spotlight section offers the latest news, interesting articles, and helpful tutorials.

http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/suite/buynow.html?asrc=vs_help
http://www.movavi.com/support/contact.html
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The Favorites board allows you to add the functions you use the most to begin working right after the program starts. To add a new feature,
click the plus button and select the feature you'd like to set up quick access to. It will appear on the quick access board. To remove a feature,
click the three dots button and then click Remove from favorites.

The features menu consists of Tools and Extras. The Tools are sorted according to the media type:
•  In the Video tab, you can choose to edit, convert, trim, or watch a video, as well as record your screen and capture TV or VHS-signal.
•  The Audio tab offers to convert, record, play and even burn your music to a CD or DVD.
•  In the Photo tab, you'll also be able to convert pictures as well as make a slideshow with music and transitions.
•  The Data tab will help you import an AVCHD video, burn a disc or copy one.

The Extras section offers you more content to enhance your videos:
•  In the Stock Content tab, you can get additional sets of special effects, as well as stock video clips, audio tracks, and images.
•  The Applications tab offers more programs for working with different kinds of media and documents.
•  The Online Courses tab features video clips and online video courses that you may use to get more professional and creative in terms of
video making.
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Clicking the Favorites button will take you back to the quick access board.

Edit video
Using Movavi Video Suite, you can create your own movies using the media files you have on hand. To open Video Editor, click Video in the
Tools menu. Then click New Project on the Edit video tile.

How to use the Editor?
Step 1: Add media

Add videos, photos, and music to your video project.
Open captured videos in the Editor

Record video
Record audio

Arrange files chronologically

Step 2: Edit video
Edit and enhance the video clips to

make your video just the way you like it.
Cut and split video

Rotate clips
Crop the frame

Apply cool filters
Step 3: Join clips with transitions

Drag-and-drop transitions from the Video Editor's
extensive collection to join clips with fun animations.

Step 4: Annotate your video
Get your thoughts across with sound and text.

Record a voice-over
Add text titles

Step 5: Save your video
Export your project to a common video format.

Save for devices
Save for uploading online

 

Activating and installing packages
Expansion packages are sets of additional content, which include transitions, titles, stickers, backgrounds, and music. The packages help
you achieve your creative goals, broaden your freedom of expression, and save time choosing the right artistic tools.
 
Acquiring a package
1.  Go to Movavi Effects Store. You can also find this this link in the Help menu > Movavi Effects Store. Or by clicking a cart icon in effect,
transition, title or sticker collections.

https://effects-store.movavi.com/
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2.  On Movavi Effects Store web-page choose and purchase the packages you like. After the purchase is processed you will receive an e-mail
with an activation key, a link to download the package, and an instruction on how to install it.

Installing a package
1.  Click the link you received with the e-mail and download the package.
2.  When the download is finished, open the package as you normally would open your project: double-click the file or drag and drop it in the
Video Editor. The program will run the installation process.
3.  In the Installing Package window click Install and follow the instructions on the screen.

Activating a package
1.  Copy the activation key from your email.
2.  Paste it in the in the Activating Package window.
3.  Click Activate.

Wait until the installation is finished. The new elements will appear in the corresponding categories. The categories with the new elements
will have a yellow dot on them and the elements will be marked with the NEW label.

 
Cannot install or activate the package? Make sure that:
•  The Video Editor you have installed on your system supports the packages;
•  You use the key that was sent to you after the purchase of a package and there are no additional symbols after the key;
•  You have enough free disk space to install the package.

Quick Video mode
You can use the Montage Wizard to automatically build a video for you in minutes. All you need to do is provide the Wizard with some video
clips or photos, choose a music track, and let the Wizard cut and build the video for you. You can also use the Montage Wizard to make
slideshows.



 

11

 
1.  Click Quick Video to open the Wizard.

2. 
 
On the Files tab, click  or drag and drop your files over the window. To remove files, click the  in the upper right-

hand corner of each file, or select the files you want to delete and click Delete Selected on the bottom panel.

3.  Switch to the Templates tab or click Next.
4.  Choose a theme or a transition template.

No transitions template does not add any transitions to your video, but your pictures will still have a Pan and Zoom effect applied by
default.
Transitions template puts some kind of smooth transitions between the slides.
Theme template uses the sample music tracks, a set of different transitions for each of the themes and various title styles.

5.  Switch to the Music tab or click Next.
6.  Add music. Choose from the built-in tracks* or add music of your own. You can also add more than one track.

*The audio tracks are royalty-free so you can upload these videos to YouTube and other services.

7.  Switch to the Preview tab or click Next.
8.  Customize the opening and ending titles, change text and click Apply.
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9.  Under the Advanced tab make other necessary changes.
•  Video duration
You can set your video to be the same length as the audio by selecting the Fit to music length option or use the slider to set how long you
want the video to be. If you opt for a shorter video, some clips may not appear in the end result.
•  Fill black bars
If the resolution of the project and the files you've added to the video are different, black bars will appear. You can remove them by
checking the Fit to frame option – the image resolution will be automatically fitted to the frame size.
Learn more about frame size
•  Volume balance
By bringing the upper slider to the right end you will turn the volume of the added video up to maximum. And by bringing the bottom slider
to the right end, the volume of the background audio track will have its maximum volume.
•  Arranging clips
If you have a lot of pictures and want to change their order in the video, click the Shuffle button. The Wizard automatically mixes your files
and puts them in a different order.

Tip: You can also set a desired order of appearance of your files by returning to the Files tab and dragging the file icons in a desired order.
 

10. Watch the finished video in the player on the Preview tab and switch to the Export tab.
11. Select what you want to do next with your video:

•  Save the video – save the video to your disk.
•  Continue editing – add final touches to your video by adding effects, more titles, animation and more.
•  Upload online – save the video to your disk and upload it to YouTube, Vimeo, Google Drive or Movavi Cloud.

 
12. To save the video, choose a video format  and pick a folder to save the video file.

If you're uploading the video to YouTube, sign in with your YouTube account and fill in the details about your video. Then click Start to
begin saving the video.
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Learn more:
Adding filters
Adding titles
Color adjustments
Removing black bars

New Project mode – quick start
In this mode you can use all the tools that the Video Editor has to offer and create professional-looking videos without complicated software.
 
You can create a new video by creating a new project or a quick video.
 
1.  To start creating a project just add files on the Timeline. If you want to start another project select Create New Project in the File menu.

2.  Click Add Files or drag and drop your files over the import area to start working on them.

 
3. Change the clip layout on the Timeline, crop images, cut videos, using the toolbar.
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4. Add effects, transitions, titles, and more by changing the tabs on the left-hand side of the screen.

5. To add filters and transitions to the project, drag them to the Timeline.

6. Save your video:
1)  Click the Export button.
2)  Choose file format.
3)  Name the video, select a folder to save the video to and set the quality.
4)  Click Start and wait until the processing is finished.
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Make sure to save your work once in a while: choose Save from the File menu to save the project so that you can access it later.

Creating and managing projects
How to create, save, and open projects and finished videos
A project keeps all the work on your video or slideshow. You can save the project to finish your work later, or restore your work if you need to
edit something after you've finished. A new project is created automatically when you start working on a video.

Creating a new project
1.  On launching the Video Editor you can start making a video right away.
2.  To start a new project while working on another project, go to the File menu and select Create New Project or Create Quick Video.

Saving projects
1.  Go to the File menu and select Save Project. Or use a keyboard shortcut Ctrl+S.
2.  Name your project. All projects are stored in the "\My Videos\Movavi Video Suite\Projects" folder of your user.
3.  Click Save.

You can later open the project file and continue working on it. To avoid losing your editing progress, make sure to save your project every once
in a while. To save a project, open the File menu and select Save Project.

After that, you can save your project as a file in the *.mepx format on your computer and open it later to continue editing your movie.

Viewing videos
Project files cannot be viewed in a regular video player, and can only be opened with Movavi Video Editor. To view the final video in a player,
you need to first export your project to a common video format.
Learn how to export your project

Opening projects
1.  Open the File menu and select Open Project.
2.  Find the project file, select it and click Open.

You can also open projects in several different ways:
A.  Find your project in Explorer and drag it onto the Video Editor window or double-click it.
B.  In the Import area click Add Files and select find your project.

Media use
When you add files to a project, Movavi Video Editor uses the original file for reference as you edit the movie. To save your disk space, Movavi
Video Editor does not make copies of the files, but rather remembers the location and name of the original file, so if you move or delete the
files, they will also disappear from the project.
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Because all of your editing work is done in the project, your original files are not edited in any way, and you do not need to make reserve copies.

How can I play my project?
Project files cannot be viewed in a regular video player, but can only be opened with Movavi Video Editor, Movavi Screen Capture Studio, or
Movavi Video Suite. To view the finished work in a player, you need to first export your movie to a common video format.
Learn how to export your project

Appending a project
If you work on a big project, you might want to separate it into several smaller ones for a more convenient editing process. Then, to combine
them back together, append other projects to the major one.
 
1.  Open a project or create a new one.
2.  Open the File menu and click Append Project.
3.  In a new window, find and open the project you want to combine with your current project. The project you append will be added at the end
of all other clips in the current project.

Adding media files
To begin working on your video project, you first need to add some media files. Use your own files or any of the built-in media.

Add your files
1.  On the File import tab click Add Files.
2.  Select the files and click Open. They will appear on the Media bin tab.
3.  From the Media Bin tab drag and drop the files onto the Timeline. You can remove the selection of all files by clicking on an empty space
within the bin area, or by selecting a single file.
 
Add built-in media
1.  On the Import tab select the type of media you want: sounds, music, sample video or backgrounds.
2.  Switch to a tab.
3.  Click the file icon to download and see it or to listen to it.
4.  Choose a media file and drag it onto the Timeline to add to the project.
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Arrange the files
Once you've added the files, they will appear on the Timeline at the bottom of the window. The Timeline allows you to arrange the clips in the
order you want. To reorder the clips, select the clips you want to move and drag them to the new position.

See also:
Working with video
Working with audio

Creating an intro
Intro videos are specifically designed short video clips that use visual elements and text and can be edited or customized. If you don't know
where to start in making a unique intro, you can use the ones that are already made and pre-installed into the program. You will only need to
change the text.
 
Create a new intro
1.  In the Titles collection go to Intro videos.
2.  Find the New intro clip and drag and drop it onto the Timeline.

Edit the intro
1.  Click  on the clip and the Timeline will switch to the intro editing mode.
2.  Add your own media files (video, audio or pictures), effects, titles and other. Work as if you're working with a usual project, but keep in
mind that your making a special introductory video.
*Before you start editing, delete the instruction clip that the new intro contains.
 
Save changes

Click  on the toolbar to save changes and go back to the main editing mode.
 



 

18

To save the intro and use it in other projects, select the intro clip and click . The intro will be saved with all the other items in the collection.
You can edit the intro at any time while working on the project.

Recoding video
1.  Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working
correctly.
2.  On the Import tab of the <НЕ ЗАБЫТЬ>: Задайте значение переменной, click Record Video. The recording module will open in a
separate window.

3.  In the Video capture device box, choose the camera.
4.  Then, select the resolution and frame rate. A larger resolution will be able to retain better quality, however, the video file size will be larger.
A higher frame rate is necessary for recording motion, while static scenes can be captured with a lower frame rate.
5.  In the Audio capture device box, choose the microphone.

6.  Choose a destination folder. By default, the recordings will be saved to your Movavi Library folder. To change it, click the icon  near the
Save files to box.

7. 
 
Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera icon  on the right.

8.  When you're done, click Back to editing at the bottom of the window. The captured files will be added to the Timeline and saved to disk.
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Preview and organize clips
Use the player in the upper right-hand part of the window to preview your project.
 
Current position
Your current playback position can be controlled using the position marker under the player and on the Timeline.

For precise positioning:
•  To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds (Shift+Ctrl+Right) or Skip Backward
by 0.5 Seconds (Shift+Ctrl+Left).
•  To move precisely from frame to frame, use the Previous frame (Ctrl+Left) and Next frame (Ctrl+Right) buttons in the player.
•  To switch between clips, use the Previous clip (Shift+Left) and Next frame (Shift+Right) buttons in the player. This will move the position
marker exactly one frame backward or forward.
•  Use the Scale slider to zoom in on the Timeline to make positioning easier.

Playing the video
1. Move the position marker to where you want to start playback.
2. Click Play or press the Space Bar key. 
3. Click the Pause button or press the Space Bar again to pause playback.
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1 – player position marker
2 – current time
3 – previous clip
4 – previous frame
5 – play/pause
6 – next frame

7 – next clip
8 – aspect ratio of the project
9 – player volume
10 – snapshot of the player
11 – additional settings of the player

 
Arranging clips
By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your
mouse and drop them onto the desired position. To select multiple clips, use Ctrl+click or click and drag to draw a selection on the Timeline.

Edit and enhance clips
Arrange, edit and enhance clips with the tools that you can find on the toolbar and on the More tab.
 

In a table below see what tools you can use on clips and how to apply them.
 

Split Set the position marker on the Timeline where you want to separate your clip and cut it.

Rotate Turn the clip clockwise.
Crop Set on the player the space you want to keep and cut the borders.

Adjust color Make the necessary color changes using presets or set them manually.
Turn the sound up or down Click Clip properties and use the Volume slide to change audio loudness.

Normalize the video sound Select the Normalize checkbox in the Clip properties to make the sound smoother.
Change video speed Click Clip properties and use the Speed slide to make the video faster.
Reverse the video Select the Reverse checkbox in the Clip properties to play the clip from the end to the

start.
Change opacity Move the Opacity slide to make the clip transparent.
Change clip length To change the clip length move the borders of the clip on the Timeline or use the Speed

slide to make the clip faster.
Make clip fade in or out Use the Fade in and Fade out slides to make the clip appear and disappear smoothly.
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Edit videos and images
Photos and videos aren't always perfect from the beginning. Use the buttons on the toolbar to fix and adjust the clips.

Picture in picture and overlays
To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of the Timeline to
create an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on the video.
Learn more about overlays

Picture and picture, side by side overlay modes.

Rotating videos and images
Nobody likes vertical videos! But don't worry, in just a few clicks, you can turn any photo or video around without having to crane your neck.
 
Rotating by 90 degrees
1.  Select the clip you want to rotate
2.  Click the Rotate button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate the video more.
Learn more: Removing black bars
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Fixing the horizon level
1.  Select the clip on the Timeline.
2.  Click the Crop button on the toolbar.
3.  Use the Angle slider to slightly rotate the clip inside the frame, until the horizon is level with the guides in the player.

 

Cutting clips
Use the scissors button on the toolbar to cut video and audio clips into parts. To delete a clip you don't need, click the trash can button.

Splitting clips into parts
1. Select the clip that you want to split.
2. Move the position marker to the moment where you want to cut the clip.
3. Click the Split button on the toolbar.
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How does the cut clip look like.
Cutting out fragments
Cut the clip at the beginning of the unwanted fragment

1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to catch
the moment precisely.
3. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

 
Cut the clip at the end of the fragment

1. Select the second clip the you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the Split button again. The fragment should now be in a separate clip.
 

Delete the unwanted fragment
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key to remove this clip. The clip will be removed, and the remaining clips on the
Timeline will move to close the gap.

Trimming clips
If you only need to cut off some parts at the beginning or at the end of a video or audio clip:
1. Place your mouse pointer over the edge of the clip.
2. Click and drag the edge towards the center of the clip to trim the clip to the desired length.

For more precise navigation:
•  Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second
forward or back.
•  Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+Left and
Shift+Ctrl+Right.
•  Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+Left and Ctrl+Right
keyboard shortcuts.
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•  Use the Previous Clip and Next Clip to switch between the clips in the player. You can also use the Shift+Left and Shift+Right keyboard
shortcuts.

 
 

Cropping video
Cropping a video can help you remove black bars, cut away the edges of the video, or permanently zoom in onto an object inside the frame.
 
1. Select the clip on the Timeline.
2. Click the Crop button on the toolbar to open the Crop tool, and a cropping frame will appear inside the player.

3. In the player, set the frame so that the parts you want to cut are outside it. Drag by the corners of the frame to change its size, and drag by
the center of the frame to move it. 

Use the Angle slider in the Crop and Rotate section on the left to rotate the crop frame.
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4. Click Apply. A star  icon will appear on the clip once you've applied cropping.
 

Removing crop
1.  Click the star icon on the clip to show the list of applied effects and filters:

 
2.  A tab will open above the toolbar. Find the Crop effect and click the cross button  next to it to discard the effect.

Color adjustments
Change color settings
1. On the Timeline, select the clip that you want to adjust.
2. On the toolbar, click the color adjustments button to open the adjustments tool.

3. Select Easy mode to use color presets for quick and simple adjustment.
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Or select Advanced mode to set your own settings.

If made your own adjustments to the image and want to save them for future use, click Save Adjustments and name your preset. The
new preset will appear on the Auto Adjustments tab.

Once you have used the adjustments, the clip will be marked with a star icon, denoting applied tools or filters: 

Video speed
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Speed up or slow down a video or audio clip with the Speed slide. This can be useful if you're working on a music video and you want the
video to match the tempo of the music.
 
1. On the Timeline, select the clip you want to edit.
 

You can also change the speed of any audio clip. If you modify the speed of a video with built-in audio, the audio speed will also be
changed.
 
2. Click the Clip Properties button to open the editing tools for the selected clip.

3. Drag the Speed slider to set the necessary video speed.

The clip's length on the Timeline will change to reflect the new speed. If you've changed video speed, the video clips will be marked with
a star icon:

Reversing video
Reversing the video will play the clip and its audio backwards. You can combine reversing the video with increasing speed and the VHS filter
to create a cool rewinding effect.
 
1. On the Timeline, select the clip that you want to reverse. You can reverse both video and audio clips.
2. On the toolbar, click the Clip Properties button to open the properties for the selected clip.
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3. In clip properties, select the Reverse option.

When you apply reverse, the clip will appear with a reverse icon on top of it:

Image duration
You can change how long each image appears in your video or slideshow either using the clip properties or you can set all images to the
same length.
 
Changing one image's length
1. On the Timeline, select the image clip that you want to edit.
2. Click the Clip Properties button to open the properties for the selected clip.
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3. In the Duration box, enter the new length of the image. Use the following format: hours: minutes:seconds.milliseconds. Changes will be
applied instantly.

You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip
appears on the Timeline, the longer it will play in your movie or slideshow.

 
 
Setting the same length for all images
To set all of the project's images to the same length:
 
1. Click the Transition Wizard button on the toolbar.
2. In the Transition Wizard window, enter the preferred length into the Image slide duration box. If you don't want to use transitions to join
your clips, select No transitions in the box at the top.
3. Click OK to set all the images to the selected length.

Fading video
In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading
simultaneously with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.
 
1. On the Timeline, select the clip that you want to fade.
2. Click the Clip Properties button on the toolbar. The clip properties will open in the Tools panel above.
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3. Set the fade length using the sliders on the Video tab.
 

Fade in – how long in seconds it will take to fade in to full opacity at the beginning of the clip.
Fade out – how long in seconds it will take to fade out from full opacity at the end of the clip.

See also:
Adding transitions
Fading audio

Creating overlays
Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect,
add a logo or watermark, create a Chroma Key effect, or insert a short clip without cutting the main video.
 
1.  Add files to the project: a background video and a foreground video or a photo.
2.  Select a clip which should go on the overlay track and drag it above the main video track.

3.  Place the clip on the overlay track at the right time on the needed position. You will see a line connecting the clip on the overlay track to the
clip on the video track. When you move, cut, or delete a clip on the video track, the overlay clip will be affected as well. When you move the
clip on the overlay track, an editing panel will open. If you switch to a different tool, you can go back to this panel by clicking More Tools —
Video Editing — Overlay.
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4.  On the tool panel select overlay mode: Picture in picture, Logo, Overlap, Side by side or Trio.

Picture in picture mode
This is the default overlay mode. Using picture in picture mode, you can place the overlay video over any part of the screen.
1.  Choose Picture in picture mode.
2.  In the player, move the overlay clip to where you want it to appear in the frame.
3.  To resize the overlay, drag at its corners. Clip's aspect ration will remain the same.

Logo mode
1.  Select Logo mode to place the overlay clip at the upper right corner and use it as a logotype.
2.  Drag and move the logo to any part of the frame.
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Side by side mode
This mode splits the frame into two parts.
1.  Select a clip on the overlay track and then choose a side by side mode.
2.  Hover the cursor over the selected clip in the player. Move the image in the frame, and zoom in or out on it with the scroll wheel.

Trio mode
With this mode you can have up to 3 videos in a single frame.
1.  Select a clip on the overlay track and then choose a side by side mode.
2.  Hover the cursor over the selected clip in the player. Move the image in the frame, and zoom in or out on it with the scroll wheel.
3.  To add another video and get three in a single frame, add one more clip to the overlay track and repeat steps 1 and 2 for it.

Overlap mode
In Overlap mode, the video on the overlay track will cover the main video completely. You can use this mode to avoid cutting the main video,
and showing another clip instead, or to create a Chroma key effect.
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Learn more:
How to change background (Chroma key)

Adding a watermark
Adding a watermark to your videos will protect your ownership even if it's shared all over the Internet. You can add an image overlay with
your own watermark or logo, or make a new one using text.
 
Image watermark
1. On the Import tab, click Add Files and add the image or video that you want to use as the watermark. For the best look, use images with
transparent areas.
2. Drag the watermark clip up to the overlay track to make it appear on top of other videos.

3. Double-click the watermark clip to edit the overlay, which you can move and resize in the player.
4. To change the opacity or duration of the watermark, click the Clip Properties button.
5. To set the opacity use Opacity slide in the properties. To make the watermark show over the whole length of the video, enter your project
length into the Duration box, or drag the right edge of the overlay clip until the end of the video track.
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Text watermark
1. Click the Titles button on the left and pick a nice title style for your watermark.
2. Drag the titles you like onto the beginning of the Titles track at the top of the Timeline.

3. Double-click the titles and enter your watermark text. Pick a cool font and color on the panel above the player. Click Apply when you're
done.
4. To make the watermark show over the whole length of the video, drag the right edge of the text clip until the end of the video track.
 

If your movie is long, zoom out on the Timeline to make changing clip length easier.
OR: Double-click the text clip to enter text editing mode and enter the length into the Duration field. You can find the length of your whole
project at the bottom of the window.

Creating a freeze frame
A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to
emphasize a moment or create a pause to explain things to the viewer.
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1. Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous
frame and Next frame buttons under the player.

2. Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.

3. By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.
Learn about changing image duration

Removing black bars
Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black bars around
them. You can remove black bars from videos using one of the ways below.

 
Use filter
1. On the Timeline, select the clip with black bars around it.
2. Click the Filters button on the left sidebar to open the Filters tab.
3. Find the Vertical fill filter in the Adjustments group and drag it onto the clip.
Learn more about filters
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Manual crop
If black bars appear only on one or several clips, you can cut off the edges to make the video fit better inside the frame.
1. On the Timeline, select the clip with black bars around it.
2. On the toolbar, click the Crop button.
3. A frame will appear in the player. Set this frame on the part of the video that you want to keep. Parts that are outside the frame will be cut
off.
4. In the Tools tab on the left, click Apply to accept the changes.
Learn more about crop

Fading effects
Make effects and filters fade in  using the overlay track.
 
1. Copy the clip and paste it onto the Timeline.
2. Drag the copy of the clip on the track right above the original. Now you have two identical clips right on top of each other.

3. Double-click the clip on the overlay track and choose Overlap mode in the panel above the player.
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4. Apply the effects or filters you want to use onto the upper, visible clip.
Learn more: Applying filters

5. With the overlay clip selected, click the Clip Properties button and select General settings. There, use the Fade in and Fade out sliders to
set the fading time. Here you can also set Opacity if you want to reduce the effect's strength for the whole clip.

The clip with the effect will gradually appear and disappear, exposing the underlying original clip.
 
 

Adding and editing audio
Add an audio
1.  To add music or other sounds to your project, open the Import tab.
2.  Select File import category.
3.  Click Add Files or just drag your files on the panel.
 
Also you can use one of the built-in music or sound tracks:
1.  Click the Music or Sound category and take your pick from our royalty-free music collection.
2.  Drag the tracks you liked on the Timeline.
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Edit an audio
To edit the audio file, double-click the audio track, the settings panel will appear.

 
Volume Sets the volume of the clip.
Normalize Makes quiet parts louder.
Speed Makes the audio play faster or slower.

Fade in The audio goes from complete silence to full volume in the time you set.
Fade out The audio goes from full volume to complete silence in the time you set.
Reverse Plays the audio backwards.

Recording audio
How to record an audio
1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the Import panel to open recording options.

 
4. Set up your recording device and volume.
5. Click Start Recording and record the audio.
6. When you're finished, click Stop Recording. You'll find the recording on the Timeline.
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Set start time for audio clips
After you've added the audio files, they will appear on the audio track of the Timeline as green clips. To change when the audio clip starts
playing, drag it along the Timeline, using the ruler at the top for time reference.

Extracting audio from videos
If you want to use a sound track from a movie, you can extract it from a video file and use it in your project.
 
On the Import tab, click Add Files and choose the video or just drag a video on the panel. The file will be added to the video track on the
Timeline.

How to trim the parts of the video if you don't need to extract the whole audio track:
1. Move the position marker to the beginning of the fragment you want to keep and click the Scissors button on the toolbar. This way you will
cut off the beginning of the video.
2. Now, move the position marker to the end of the fragment you need. Click the Scissors button again, and the fragment will now be in a
separate clip. 3. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.

3. The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down
onto the audio track. If you don't need the video clip anymore, just delete it.
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You can now work with the extracted audio clip separately.
 

If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button at the top of the program.
2. In the Export window, switch to the Save Audio File tab.
3. Select an audio format.
4. In the Save to field you will see where on the disk the file will be saved by default. To change that folder, click Browse and select a new
folder.

5. Finally, click Startto save the audio file.

Looping audio
If the music file is shorter than your video, you can loop the audio and have the file play over again until the end of the video.

1.  To copy the audio clip, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu.
2.  Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until the
audio length is greater or equal to the video length.
3.  Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip, and
drag it to the left.
 
 

Volume curves
Volume curves allow to control the volume for each part of the clip and smoothly increase or decrease the volume.

Each clip has its own volume curve that starts out at 100% volume for the entire clip, and two points at its beginning and at the end. The white
line on the image below is the volume curve before you add any points.

Set the volume level
1. Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

2. Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume
Point from the pop-up menu.
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3. Drag the audio point to the necessary volume level. You'll notice that the surrounding parts also move with the point to make the transition
smoother.
4. Make as many points as you need for each part of the clip where you'd like a peak or a drop in volume.

5. To set the volume level for a part of the clip, you'll need at least two points. Create a point at the beginning and at the end of the fragment:

6. Create as many volume points as you wish to make a necessary effect.

Linking audio
To make audio clips to stay in sync with videos or images as you edit your project, link it to each other.

To link an audio
1.  Select an audio clip on the audio track at the bottom of the Timeline.
2.  Drag the track under the video clip you want it to link to.
3.  On the left side of the Timeline click the Link button to create the connection between audio and video clips.

Fading audio
In the editing tools, you can add smooth fades to the beginning or the end of a clip and create a crossfade effect between audio tracks.
 
Fade in – how long in seconds it will take to go from silence to full volume at the beginning of the clip.
Fade out – how long in seconds it will take to go from full volume to silence at the end of the clip.
 
Set up the fading effect
1.  Select the clip on the Timeline.
2.  Click the Audio Properties button on the toolbar.
3.  Set the fade length using the sliders on the Clip Properties panel.

Equalizer
Using the equalizer, you can boost or reduce the levels of specific frequencies.
 
Set the equalizer
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1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Equalizer.

3. Choose an equalizer preset to set the effect quickly. If you want to set more advanced configuration drag the volume bars to adjust the
frequencies to the necessary level.

4. To save your own equalizer presets for their further use, click the Save button. In the new window enter a preset name and click OK. The
created preset will appear in the presets list.

Noise removal
1.  Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2.  Click More on the left sidebar and find Audio Editing to open Noise Removal.

3. Use the Noise suppression slider to set the amount of noise you want to remove.
 

Don't set the noise suppression too high if there isn't much noise because it can start muting other sounds.
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Audio effects
Audio effects can transform the sound of an audio clip.
 
1.  Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2.  Click More on the left sidebar and find Audio Editing to open Audio Effects.

3. Click the box in the Audio Effects section and choose an audio effect you like.

Removing effects
When you've applied an audio effect to a clip, a star icon will appear on it:

Click on the star to see a list of applied effects. Then, select the effect you don't want and click the cross button  to discard the effect.



 

44

Beat detection
To make your video more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and then adjust your
video to the beat of the music.
 
1. On the Timeline, select the music that you want to detect beats for.
2. Click More on the left sidebar and find Audio Editing to open Beat Detection.

3. In the Beat Detection tool, click Detect Audio Beats. The program will analyze the music and place beat markers on the Timeline.

After the beat markers have been placed, you can modify their tempo. Use the Min time between beat markers slider to make the beat
slower or faster.

4. Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.
 
Removing beat markers
1. To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select Remove Beats from the pop-up menu.
2. To remove all beat markers from your project, right-click the Timeline ruler and select Remove All Beats from the pop-up menu.

Filters
Add filters
1. Click the Filters button.
2. Choose All to see every filter in the collection or choose the specific category you need. To see the filter’s preview in the player, click on it.
To find a specific filter, enter its name into the search box above the filters. Click the heart icon to add the filter you liked to the Favorites
group.
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3. To add a filter, drag it onto the clip you want to apply the filter to.
 

You can apply a filter to several clips at once. Hold the Ctrl key, select the clips on the Timeline and drag a filter onto any of the selected
clips. The filter will be applied to all the clips you've selected.

Once you've applied a filter, a star icon will appear on the clip, indicating applied filters and tools.

Clip with an applied filter
Remove filters
1. To see the list of applied filters and tools, click on the star  icon on the clip.
2. In the list, find the filter that you want to remove.
3. Click the cross button  to discard the effect.

Transitions
Transitions are short animations that use geometric shapes and transparency to connect two clips.
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Add a transition
1. Click the Transitions button on the left sidebar to open the list of all transitions. Click on a transition to preview it in the player.

 

2. Pick a style you like and drop it between two clips on the Timeline. Click the heart icon  to add it to your favorites list if you like it.

A transition icon will appear between the two clips.

Change transition length
1. Double-click a transition on the Timeline to open transition properties.
2. Enter the new transition length in the Duration field. By default, each transition will be set at 2 seconds long. The format is
seconds:milliseconds. If you want all transitions that are currently in the project to have the same length, select the Apply to all transitions
option.
3. Click OK to apply the changes.

There are more options to fill the transitions with, such as:

Trimmed content If you've trimmed the video, the trimmed bits will appear during the transition. If the
videos haven't been trimmed, a freeze frame is shown.

Freeze frame A static frame is shown during the transition.
Slow motion The part of the video overlapped by the transition is stretched to fill the entire duration.
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Remove a transition
1. Right-click the transition on the Timeline and select Remove Transition from the pop-up menu.
2. If you want to delete all the transitions in your project, choose Remove All Transitions.

Titles
Add text to your video
1.  Click the Titles button on the left side of the window to view the titles collection.

2.  Click on a title style to preview it in the player and choose the titles you want to use. To add titles to your favorites, click the heart icon .
3.  Pick a title style and drag it onto the title track of the Timeline. Put it right above the video track, onto the time where you want it to appear.

4.  You can link titles to the clips by clicking the link icon  on the left side of the title track, so that the titles will move with the clip.

Edit titles
To change the titles' text and design, double-click the title's clip on the Timeline or in the player. The setting panel will appear.
1.  On the Text tab, choose a font, a color, size, and alignment. If needed, add an outline and background color by selecting the options and
changing its properties on the bottom of the tab.
2.  On the Clip tab, change the duration of the clip and animation speed of a title.
3.  To change the color of the style and switch to the Color tab, select a non-text element of the title in the player.
4.  On the New Preset tab, save the title preset with the adjustments you made to use it in other projects.
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5.  Click Apply to save the changes.

6.  To change the position of a title on the screen, double-click a clip on the Timeline. In the player, you will see a frame appear around the
object. Drag the corners of the frame to change the size and drag the object itself to move it. To rotate titles, click and drag the top white dot
of the frame.

Move several objects at once by selecting them with the mouse cursor or by holding the Ctrl key and clicking the objects with the left
mouse button.

Timer
Add a timer
1. Click the Titles button on the left sidebar to open the list of available text styles.
2. Find the "Timer" title style. Use the search bar or click the Basic group to filter the styles.
3. Drag the Timer titles onto the title track of the Timeline. To change the length of the timer, drag the edges of the clip.

Edit the timer
1.  Double-click the timer clip on the Timeline.
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2.  Edit the text formatting on the Text tab, if needed.
3.  Switch to the Timer tab.
4.  Change the time format to the suitable one, for example, ss:zzz.
5.  In the From field, set the starting time. If you select to set a countdown, it will also begin from the time you set in the From field.

Saving a preset
After you set up your title style, you can save it and use if in future projects.

1.  Double-click a title clip and adjust it to your preference. Then switch to the New Preset tab.
2.  Name new preset.
3.  Click Save.

You can find your titles on My titles tab.

Stickers
Add stickers
1. Click the Stickers button on the sidebar to open the list of stickers.

Click a sticker to preview it in the player. If you liked a sticker, click the heart icon  to add the sticker to your favorites list.
2. Select the sticker and drag it onto the title track of the Timeline. All titles, callouts, and stickers go on the title track. Change the length of
the sticker to make it fit the clip.

 
Edit the sticker
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1. Double-click to open the sticker settings.
2. Select the duration of your sticker.
3. Click Apply to save the changes.
 

4. To change the sticker's position on your video, double-click the sticker clip. In the player, drag the corner of the frame around the sticker
to change its size, and drag the center of the frame to move the sticker. To rotate the sticker, click and drag the white dot at the top of the
frame.
5. Click Apply when you're finished.

Transitions cannot be applied to stickers, but you can animate them.
Learn more: Animation

Animation
You can move objects any way you want and make creative appearances.

Add animation
1. Add the background onto the main video track.
2. Add the object you want to animate.

3. Click More and in the Video Editing choose Animation.
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4. Select Easy mode to add quick and simple animation. To use the preset, just drag it on the clip.
   
To create your own unique animation, select Advancedmode.

Advanced mode
1. Select the clip you want to animate and place the position marker where you want your animation to be started.
2. In the Animation panel, click Add Animation.

3. In the player, you will see a frame appear around the object. Use it to set the position of the object.

On the Timeline, two points will appear on the clip. They are called keyframes. The first point is the original position of the object. The
second point will be its end position after the animation. The distance between the two points determines the animation speed.

Edit the keyframes
On the Timeline, double-click a keyframe to edit it. Adjust the animation:

    
Move the object on the player Use the frame of the object
Change the size Drag the corners of the frame
Rotate the object Drag the white dot at the top of the frame
Make it spin Use the Angle box on the Animation panel
Make the object fade in or out Use the Opacity slider on the Animation panel
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Change the speed of your animation Move the keyframe point on the clip:
•  Move the points closer together to make the animation go faster.
•  Move the points farther away from each other to make it go slower.

To add another keyframe, move the position marker to where you want to place it in the clip and click Add Keyframe on the Animation panel.

Reset a keyframe
To make a keyframe go back to its original position, right-click the keyframe point on the clip and select Reset Keyframe in the pop-up menu.

Remove keyframes
1. To remove one keyframe, right-click the keyframe point on the clip and select Remove Keyframe in the pop-up menu.
2. To remove all keyframes and delete the animation, right-click any of the keyframe points and select Remove All Keyframes.

Pan and zoom
You can control the camera movement using two keyframes and smoothly move from one frame to another.

Add the Pan and Zoom tool
1. On the Timeline, select the clip that you want to zoom.
2. To open the Pan and Zoom, select More on the left sidebar and find the Pan and Zoom tool in the Video Editing.
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3. Select one of the presets and click it to apply.

This will add two keyframes to the clip. The camera will move between these two keyframes and you can set up camera movements from
one point to another.

4. To change the beginning keyframe, double-click the first point on the clip. Then, use the frame in the player to set the zoom level for the
starting point of the camera movement.
5. To change the ending keyframe, double-click the second point on the clip. Then, use the frame in the player to set the zoom level for the
ending point of the camera movement.

To change the length of the zoom effect, move a keyframe left or right. To move the zooming effect on the clip without changing its length
or other settings, move it along the clip.

If you want to add more camera movements, repeat steps 2-4 to combine other camera movements in one clip. For example, you can
zoom in on an object, pan across the frame with the same zoom level, and then zoom back out to 100%.

Add the Pan and Zoom effect to all the image clips automatically
1. Select necessary images on the Timeline.
2. Click Transition Wizard button on the panel above the Timeline.
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3. Select the Pan and Zoom checkbox.
4. Click OK to apply the effect to the clips.

Remove zoom
To remove a pan or zoom effect, right-click a keyframe and select Remove All Keyframes to clear all zoom effects from the clip. To remove
only the selected keyframe, select Remove Keyframe.

Stabilizing video
If you're filming with a handheld camera, it's likely that there might be some unwanted camera shake visible on the video, especially if you
walk or move while filming.

Stabilize a video
1. On the Timeline, select the clip you need to stabilize. To the process shorter, you can cut the video into smaller segments.
2. On the left sidebar, click the More button select Stabilization from the pop-up list.

3. Click Stabilize to open stabilization options. The Stabilization window will open.
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4. Set up stabilization with the following parameters:
Accuracy Affects the analysis precision of the video.

Shaking Sets how strongly the shaking is visible on the video.

 
To open the Advanced settings, click the Arrow button and set up stabilization with the following parameters:

Radius When a video is stabilized, each object is adjusted using the pixels from
the surrounding area. The radius affects how large that area will be. Use a
smaller value for more dynamic videos to avoid mixing objects together and
to preserve more detail.

Smoothing Limits camera acceleration. Higher values work best for more or less static
videos. Excessive smoothing may limit panning.

Edge Cropping Eliminates distortion artefacts like blurred areas from the video. There are
several options such as:
•  None: the edges will remain as they are. Best results if there is little
shaking on the video.
•  Fixed: the video is cropped to one size to cut off some of the edges.
•  Adaptive: whenever there is a lot of shaking, the video will zoom in so that
the distorted edges are not shown.
 

 
5. Click Stabilize to start processing the video. This may take a while depending on the length of your video and the selected parameters.

6. To save the result, click Apply and you will replace the clip on the Timeline with the stabilized video.

A stabilized copy of the file will be created under "\My Videos\Movavi Video Editor\Stabilized". This copy will be used in the project. If you delete
the stabilized copy, you will lose all the changes made.

If you don’t have enough space to save the stabilized copy, you can free some disk space and try again, or save stabilized copies on another disk:
1. Open the Settings menu and choose Preferences.
2. Switch to the Files tab.

3. Find the "Store stabilized videos in" box and click the button  on the right to choose another folder on a drive.
4. Click OK to accept the changes.
5. Try stabilizing the video again.

Highlight and conceal
This tool will help you to control the focus in the frame, and blur or darken parts of the video.
 
Apply the Highlight and Conceal tool to the video
1. On the Timeline, select the clip that you want to edit.
2. To open the Highlight and Conceal, click the More button on the left sidebar, and choose Highlight and Conceal in the Video Editing tab.
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3. Choose Conceal if you want to hide an object, and Highlight if you want to make an accent on the object.

4. Choose a shape for the mask: you can use a rectangular or an elliptical one.
5. Choose a masking effect: Blur, Matte (black cover-up) or Pixels. Use the options below to set up the mask:
     Opacity – makes the mask more transparent (for matte and blur);
     Feathering – makes the edges of the mask softer (for matte and blur);
     Size – changes the size of the pixels (for pixel masks only);
     Outline – adds a white outline around the mask.

6. To change the size and shape of the mask drag its corners in the player, drag by the center of the mask to move it on top of the object.
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If you want to cover up or highlight more than one object, click Add Mask at the top of the setting panel to create another mask.
 

7. Click Apply on the Highlight and Conceal panel to save the changes.
 

Chroma key
The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.
 
Add Chroma Key
1. Add the video or image clips that you want to use as the foreground and the background.
2. Select the foreground video and move it up, onto the Overlay track.
3. Double-click the foreground video to open Clip Properties.
4. To make the foreground video completely cover the background video, select the Overlap mode.
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5. On the left sidebar, click the More button and in the Video Editing list find Chroma Key.

6. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color
you've picked will become transparent.

Use more settings:
Tolerance Set how many similar shades of the selected color should also be removed.
Noise Choose how sharp the object's edges should be.
Edges Choose  how thick the object's edges should be.
Opacity Set the transparency of the background

 
7. Finally, click Apply to accept the changes.
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Exporting videos
When you're done with your project, you'll need to export it as a media file to be able to play it on the devices. This section will guide you
through the process of exporting your project to a popular video format. If you want to find out more about other ways of saving videos, see
the following guides:
Saving videos for devices
Uploading videos online
 
Export a video
1. To start saving the video, click the Export button under the player. The export settings window will open.
2. Choose a format for saving the video in. 

Some formats allow you to choose between video codecs. If you don't know which format to choose, try using MP4. The MP4 format is
supported by most platforms and operating systems.
At lower resolutions, the file will be significantly smaller, however, the video will lose some quality due to the limitations of digital data
compression.
The GIF format is different from other formats in the list. It allows saving video as a mute animated image, which can then be played in some
image viewing programs or in any web browser.

 
3. If you want to change the resolution, aspect ratio, or other settings, click the Advanced button to view and edit the project settings. To
save the changes click OK.
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4. Name your file and choose a destination folder.

In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.
 
5. Choose the quality of the video.
 

If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.
 
6. Click the Start button to begin processing the video file. This may take up to a few minutes.

https://img.movavi.com/online-help/videoeditorplus/15/preferences_ve.htm
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Export only audio
This section will guide you through exporting just the audio track of your project.
 
Export an audio
1. Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

2. Click on the Save Audio File tab in the left part of the Export window.

 
3. Select the format you'd like to save the audio in.
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While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high
audio quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the
original files: due to data compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC
audio, and vice versa – high quality files may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.
 
4. Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.
 
 5. Click the Start button to begin processing the video file.

 

Export for devices
This guide will help you export your video project for playing on mobile phones, tablets, and other devices.

1. Click the Export button under the player to open the export settings window.

2. In the left part of the Export window click on the Save for Devices tab.

https://img.movavi.com/online-help/videoeditorplus/15/preferences_ve.htm
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3. Choose a format.
 
On this tab you will find a number of different types of devices for which you can choose a format. You can choose between devices running
iOS (iPhone, iPad, iPad mini) or Android, Samsung Galaxy S6 and Galaxy S7, Google Nexus 6 and Google Pixel, as well as Playstation and Xbox
consoles. If your device is not on the list, choose Other.

You can select High or Highest quality to export the finished video with a higher bitrate. This will increase the output file size but will preserve
better quality. For most other projects, Good quality will provide a nice result at a small file size.

4. Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified
in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path
manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.

5. Click the Start button to begin processing the video file. This may take up to a few minutes.

https://img.movavi.com/online-help/videoeditorplus/15/preferences_ve.htm
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Export for TVs
This guide will help you export your video project for playing on Smart TVs.

1. In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

2. In the left part of the Export window click on the Save for TVs tab.

3. Choose your TV brand and the necessary resolution. If your TV is not on the list, choose Other 1080p TVs or Other 4K TVs.
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If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This
will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small file size.

4. Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified
in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or enter the path
manually into the box. Name your video in the Title field: the project's name will be filled in for you by default.

5. Click the Start button to begin processing the video file. This may take up to a few minutes.

Uploading online
After you finish your video, you can share it to YouTube, Vimeo or Google Drive right from the export window.

Upload online
1. Click the Export button to open the exporting window.

https://img.movavi.com/online-help/videoeditorplus/15/preferences_ve.htm
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2. In the left hand part of the Export window click on the Upload Online tab.

3. On the Upload online tab select the service you would like to upload your videos to: YouTube, Vimeo or Google Drive.

4. Click Sign in. The authentication page will open in your browser.
Sign in to your account and click Allow to let Movavi Video Editor Plus upload videos.
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5. In the Export window, open the Resolution list and choose a resolution that suits your project.

Upload to YouTube
1. Fill in the title and description for your video.
2. Add some tags to help users find videos by relevant topics. Separate tags with commas and add a number sign (#) before each one.
3. Choose a category to help viewers find relevant content.
4. Open the Privacy box and choose who you want to see the video:
Private – videos can only be seen by you and the users you choose.
Public – videos can be seen by and shared with anyone.
Unlisted – videos can be seen and shared by anyone with the link.
5. Click Upload to export your video.

Upload to Google Drive
1. Fill in the title for your video.
2. Select a Google Drive folder where you want your video to be uploaded. You can create new folders in your Google Drive storage straight
in the export window.
3. Open the Privacy box and choose who you want to see the video:
Private – videos can only be seen by you and the users you choose.
Unlisted – videos can be seen and shared by anyone with the link.
4. Click Upload to export your video.
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Upload to Vimeo
1. Fill in the title and description for the video.
2. Set the level of privacy:
Anyone – any person can watch the video.
Only people I follow – only people you're subscribed to can watch the video.
Only me – nobody, but you can access the video.
3. Select the resolution of the video and add tags.
4. Click Upload to export your video.

Save and upload the video
Before uploading, the video will be saved as a file on your computer.
1. To change where the video file is stored, click Browse and select a folder.
2. Click Upload to begin saving and exporting the video.

Editor preferences
To open the preferences:
1. Click the Settings menu
2. Select Preferences.
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The Preferences window will open. The preferences are organized into tabs. Click on a tab to open the relevant options.

3. When you're done, click OK to close the window and apply the preferences.
 

See also:
General preferences
File preferences
Acceleration preferences
Sharing preferences

General preferences
Interface Language – to change the interface language, simply select the necessary language from the list and click OK to apply the
changes.
 
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates within your version
are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.
 
I give consent to send anonymous usage stats to Movavi – check this box to let the program send usage statistics to our development team
and help us to fix all the problems in the program much faster. The data contains no personal information, will not be disclosed to third parties
and will be used for software improvement purposes only.
 
Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and you
see an error message when you start the program.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.
 
If Movavi Video Editor runs without showing an OpenGL error message, this option is not recommended.
 
Play notification sound when exporting is finished – when saving a project as a media file, you'll be notified as soon as the process is
completed.
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File preferences
On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different
location.

 
Save project files to – a folder for saving and opening projects. This folder will also store any autosave files for new projects. You can use the
autosave file to restore your work in case of an error or force close.
Save output videos to – a folder for exporting media files.
Store audio recordings in –a folder for the audio clips that you record in the Editor.

If you delete these audio files, the audio recordings in the project will also be unavailable.

Store stabilized videos in – a folder for a stabilized copy of the original when you stabilize a video.

Don't delete these files while you are working on the project, or you'll have to stabilize the files again.

Changing where the files are stored
Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in
another way.

1. Click the button with three dots  next to the folder you want to change.
2. A Windows Explorer dialog box will open. Choose the folder you want to save the files to.
3. Click Select Folder to use this folder.
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Sharing preferences
On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.

To sign in:
1. Click Sign In. The authentication page will open in the browser.

2. Sign in to your account.
3. On the next page, allow Movavi Video Editor Plus to upload videos to your account.

4. Return to Movavi Video Editor Plus. Your name will be shown in the Preferences window.

To sign out or use a different account:
Click Sign Out. After this, you will need to sign in again to upload videos.
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Acceleration preferences
If your computer is equipped with the necessary hardware, these options can help speed up encoding and decoding of media files, allowing
you to save your movies much faster and enjoy smoother performance.

Enable Intel hardware acceleration
Accelerates video processing by up to 400% when working with H.264 and MPEG-2 video codecs.
This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology.

Enable NVIDIA hardware acceleration
With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50%
faster.
Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other
programs.
This option is only available if your computer is equipped with an NVIDIA graphics card that supports this technology.
 
Compatible graphics cards
NVIDIA acceleration supports GeForce, Tesla and Quadro graphics card series. You can find the full list of supported GPUs on NVIDIA®'s
official site: NVIDIA NVENC supported GPUs.

Enable AMD hardware acceleration
With this option enabled, you can use AMD's graphics processing power for converting videos.
Using the graphics card instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering
while converting videos.
This option is only available if your computer is equipped with an AMD graphics card that supports this technology.

Fast Track HD Acceleration

https://developer.nvidia.com/video-encode-decode-gpu-support-matrix
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Fast Track HD Acceleration provides smooth and fast program running. By enabling HD clips optimization in the Preferences menu you allow
the video editor to create copies of the project files in a smaller size and then use them in the project instead of the original ones. To enable
this feature you need to have free disk space, so the Editor can store and use the copies. Once you finish editing and begin export, high-quality
files will replace all the temporary optimization copies.

Troubleshooting
If acceleration options are unavailable:
Your computer might not have the right hardware.
If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the
manufacturer's website: Intel Download Center | NVIDIA Driver Downloads | AMD Download Center
________________________________________________________________________________________________________________________________________________________________________
Intel HD Graphics is a trademark of Intel Corporation.
NVENC is a trademark of NVIDIA Corporation.
AMD  is a trademark of AMD Corporation.

Convert files
Using the Сonverter program, you can change the format of video, audio and image files, convert files to play on devices or prepare files for
uploading online.

What can I do with the converter?
Convert video files to a different format
Convert videos for watching on devices

Convert videos for uploading online
Convert audio files

Change image format
Create a GIF from a video

 
How to use the converter?

Step 1: Open the Converter app Step 2: Add files
Use the buttons at the top to open the files you want to convert.

Step 3: Choose an output format
Select the format you want to convert the files to.

Step 4: Edit and choose conversion options
Make changes to the files before conversion.

Audio tracks
Subtitle tracks

Reduce size
Step 5: Choose the output folder

Select the folder where the newly converted videos will be stored.
Step 6: Convert!

Click the Convert button to start processing the files.

Launch the converter
To launch the conversion app:
 
In the Movavi Video Suite launcher, click Video on the Tools. Then click Launch on the Convert video tab.

https://downloadcenter.intel.com/
http://www.nvidia.com/Download/index.aspx?lang=en-us
https://www.amd.com/en/support
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In the Movavi Video Suite launcher, click Audio on the Tools. Then click Launch on the Convert audio tab.

In the Movavi Video Suite launcher, click Photo on the Tools. Then click Launch on the Convert images tab.

Converting media files
Open files
1.  Click the Add Media button at the top and choose the desired type of file.
2.  A Explorer dialog box will open. Select the files you want to convert.
3.  Click Open. The files will now be added to the file list.
4.  Or drag and drop files into the program or click in the center of the main window.
Opening media
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Choose output format
In the lower half of the window, you will find tabs for any type of files and devices — Video, Audio, Images, Devices.
Popular is a tab with popular conversion formats. The used presets will be put into this tab too.
1.  Click the desired tab, Video, for example.
2.  Click the format you want to use. You can also type format or device name into the search field.

3.  For video, choose the preset with the codec and resolution that you want to use.
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Each preset displays information about the video, audio, and other output parameters that can help you choose the right one.
Learn more about file media streams and customizing presets.

Edit and rename the file
•  If you want to edit one of the videos, click the Edit button next to it to open the Editor window.
•  To rename the file, click the pencil icon next to the output file name and enter the new one into the Output file name box. Then, click OK to
accept.
Learn more about Editing files

Check output folder
•  At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous folders
by clicking the check near the Save to... button.
•  Finally, click the Convert button to start processing the videos. This may take anywhere from a few seconds to several hours, depending on
the size and number of video files.
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Opening media
To begin converting media files, you will first need to open them in Movavi Video Converter.
 
Add media
1.  Click Add Media at the top of the window.
2.  Click one of the buttons to open files of that media type.
3.  A Explorer window will open. Find the files you want to convert and click Open to add them to the queue. Or simply drag the files from any
Explorer window onto Movavi Video Converter to add them to the queue.

Drag and drop
Find the files you want to convert in Explorer and drag them onto the Movavi Video Converter window. The files will now be added to the
conversion queue.



 

78

Choosing output format
After you've added media files, it's time to choose the output format for converting all of the files in the list. Follow the steps below to choose
a video output format.
 
1.  In the lower half of the window, click the desired tab to see a list of formats. For example, Video
2.  Click the format that you want to convert the files to. A list of presets for this format will appear. For example, MOV
3.  Choose the video codec and resolution that you want to use.
To convert without changing the resolution, choose the preset marked with "Original size" or "Same as input".

Each preset displays information about the video, audio, and other output parameters that can help you choose the right one. 

Choosing the right resolution
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A video's resolution is its size in pixels, horizontally and vertically. It is usually listed as the width times height: 1920x1080, or just the height:
1080p. This means that the video is 1920 pixels long and 1080 pixels tall. The higher a video's resolution, and the more pixels it has, the more
detail it can preserve.
 
First of all, you need to know the original file's resolution. To do that, check the video information next to the file's preview. When you choose
the output resolution, select the same resolution to preserve the original quality, or choose a lower resolution to reduce the file size.
 
Advanced settings
If you can't find a suitable preset, you can select the necessary properties manually. Click the Customize button next to the 'Output format  '
box to modify the video and audio properties of the currently selected preset.
Learn more

Compressing files
Compressing videos can help reduce the size of the output file by reducing their bitrate. When you compress a video, it loses some of its
original quality, but even a small bitrate reduction can make the file significantly smaller.
 
Open files
Open the files you want to compress.
Learn more
 
Choose the output format
The video's format and resolution play a very important role in the output file size. 
 
1.  Click the Video tab to see a list of video formats.
2.  Click the format you want to convert the videos to.
Note: Some formats and codecs compress video better than others. If you're not sure which format to choose, use the MP4 format with the
H.264 codec for the best size to quality ratio.
3.   From the format list, choose the resolution that you want to use.

Choosing the resolution
A video's resolution is the number of pixels in every frame. A higher resolution can preserve more information and quality, but it also requires
more disk space. Select a slightly lower resolution if the video is very large. For example, you can convert 1080p videos to 720p.
Learn more
 
Compress video
1. In the file list, check the file's output size in the second column from the left.

2. Click the file size information to show compression options. There, choose the bitrate type.
 
Constant bitrate (CBR) allows you to get an output file with the exact size (recommended for DVD recording and streaming). During CBR
encoding, the bitrate or the number of bits per second is kept the same throughout the encoding process.
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Variable bitrate (VBR) allows you to reduce output file size up to two or three times saving the quality. But the file size cannot be predicted. 
During VBR encoding process the bitrate of the media file will dynamically increase or decrease depending on the media files bitrate needs.
Use VBR unless you have a specific need for playback on a device that only supports CBR.

3. Click Apply bitrate to all files in the compression box if you want to unify quality of the files.
 
If you want to check the quality of the output file without converting the whole file, click the Convert sample button. You can set the duration
of the fragment to the right of the button. The folder with the converted fragment will be opened automatically.
 
Convert
Click Convert to start processing the compressed file.

Converting DVDs
The era of the DVD disc is coming to an end, and not all homes now have a DVD drive. Make your favorite movies future-proof by backing
them up to your computer.
 
Open DVD
1.  Insert the disc into your DVD drive. If you have an external DVD drive, connect it to the computer.
2.  Click Add Media in the upper left-hand corner of the window.
3.  Hold your mouse pointer over Add DVD.
4.  Click the disc name in the menu that appears. If you don't see the DVD in the list, click Open DVD and find the DVD location.
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Tip: some DVDs are protected from illegal copying and cannot be converted. Movavi Video Suite is not intended for copying protected media.
 
 
Choose video format
1.  In the lower part of the window, click the Video tab to see a list of video formats.
2.  Choose the group with the format you like.
3.  Click that format and pick a video resolution. To convert with the original resolution, choose the line marked with "Same as input".

Choose files and streams (optional)
Many DVDs come with bonus clips, as well as a number of subtitle tracks. Select just the files you need to save disk space:
 
Bonus files
To remove bonus files that you don't need, click the  icon to the right of the video.
 
Audio tracks
1.  Find the audio information in the right-hand part of the file list and click on it to open the list of audio tracks.
2.  Deselect the audio tracks that you don't want to keep.
Learn more about audio tracks
 
Subtitles
1.  Find the subtitle information in the right-hand part of the file list and click on it to open a list of available subtitles.
2.  Choose the subtitle track that you want to keep.
Learn more about subtitles
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Convert
•  At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous folders
by clicking the check near the Save to... button.
•  Finally, click the Convert button to start processing the videos.

Creating GIFs from videos
Open a video
1.  Click Add Media in the upper left-hand corner of the window and choose Add Video from the pop-up menu.
2.  Find the video you want to turn into a GIF and click Open.
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Trim the video
Usually, GIFs are pretty short, which means you'll need to trim the video to show just the important part.
1.  Click the Edit button next to the video in the file list to open the Editor window.

2.  Cut the video as you need.
3.  Click Save and Close to finish trimming and close the editor.
Learn more about trimming files

Choose GIF format
1.  In the lower half of the window, click the Images tab to see image formats.
2.  Click GIF to see GIF conversion options.
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3.  Choose a size for your animated GIF. For example, "Medium GIF".
4.  (Advanced) To change the frame rate, click the Customize button next to the output format at the bottom to customize the selected
preset. In the settings window, choose the frame rate you need and click OK. Higher frame rates will make the movements seem smoother,
but will increase the GIF's file size.

 
Save the GIF
1.  At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous
folders by clicking the check near the Save to... button.
2.  Click Convert to save your animated GIF.

Merging files
Add files
Click Add Media in the upper left-hand corner and choose Add Video from the pop-up menu. Open the files you want to merge.

Merge files
1.  The files will appear in the joined video in the same order as they are shown in the list. Drag the files with your mouse to the right order.
2.  Select the Merge files option at the bottom of the window. All the files in the list will now be queued for merging.
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Convert
1.  Select an output format for the new video. See also: Choosing output format
2.  Click Save to... box and choose where to save the output video.
3.  Click Convert to start joining the files.

Troubleshooting
If you see an error after selecting the Join files option, make sure that all of the files in the list have the same number of audio tracks. Click
the audio information and disable the extra audio tracks. See also: Choosing audio tracks

Customizing presets
After selecting a preset, you can manually modify it to change any output properties. To do that, click the cogwheel button next to the Output
format box to open the settings for the selected preset.

 
To see more settings, click Show Advanced at the bottom of the settings window.
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Two Pass Encoding
Encoding videos in two passes means that the encoder will go over the media file twice: first, to analyze the file and then to convert it using
the collected data. This takes extra conversion time, however it allows for a higher output quality and possibly a slight reduction in file size.
 
To enable two pass encoding:
1.  Inside the Settings window, click Show Advanced to show the encoding settings.
2.  Under Encoding type, choose Two Pass.
3.  Click OK to accept the changes.
 
Tune settings
You can use Tune for advanced settings of H.264 videos.
Tune optimizes the preset settings for the best quality depending on the type of the input video:
 
• Film – for action movie content
• Animation – for animated cartoons
• Grain – for grainy, detailed video material
• Stillimage – for still image footage
• PSNR  – for achieving high peak signal to noise ratio
• SSIM – optimization for structural similarity
• Fast Decode – for faster decoding
• Zero Latency – for streaming video.

Choosing an image format
Most applications and web services are limited to just a few image formats, and working with rare formats usually requires expensive
software. Convert images to be able to use them wherever you like!
 
Open images
1.  Click Add Media in the upper left-hand corner of the window.
2.  Click Add Images in the pop-up menu.
3.  Choose the images you want to convert and click Open.

 
Choose format
1.  In the lower half of the window, click the Images tab to see a list of image formats.
2.  Click the format you want to use.
Note: not all formats support transparency. If the images have transparent areas, choose the PNG or BMP format.
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Reduce the file size (converting to JPG only)
Click the file size to open settings, then drag the slider to reduce the image size.

Edit image (optional)
You can quickly fix or improve any images before converting. To do that, click the Edit button next to the image you want to adjust.

Learn more: Applying a watermark | Enhancing colors | Cropping videos and images
 
Resize images (optional)
To batch resize the images:
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1. 
 
At the bottom of the window, click the cogwheel icon  next to Output format.

2.  Click the box under Frame size and choose a size that you want to use for all images, or choose any of the following and enter the size into
the width and height boxes on the right:

Custom: scales the images to exactly the size you specify.
Smart fit: scales the images up or down as close as possible to the specified size without changing the proportions.
Up to size: scales the images down as close as possible to the specified size without changing the proportions. Images smaller than
this size will remain unchanged.

To allow changing the image proportions, click the link icon next to the width and height boxes:  – locked,  – unlocked.
 
3. If the new size is different from the original image proportions, choose a resize method for your images:

Letter box – unused space will be filled with black.
Stretch – the image will stretch to fill the entire area.
Crop – the image will be resized to fill the entire area, and overflowing edges will be cut off.

 
4. Click OK to accept the changes. If you want to preview the result, click the Edit button next to an image.

Save and convert
At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous folders
by clicking the check near the Save to... button.
Finally, click the Convert button to start processing the images.

Choosing an audio format
Even though MP3 is the most commonly used format, you may also encounter other formats, such as AAC or FLAC, which can preserve
audio quality better, but aren't supported by all devices. Converting audio will not only let you play music on any device or player, but also
organize and compress your media library.
 
Open music
1.  Click Add Media in the upper left-hand corner.
2.  Click Add Audio in the pop-up list.
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3.  A Explorer dialog box will appear. Choose the audio files you want to convert. Or simply drag the audio files onto the converter window.
 
Choose audio format
1.  In the lower part of the window, click the Audio tab to see the list of audio formats.
2.  Click the format you want to convert the audio to.
3.  Choose the bitrate that you want to use. To convert without changing the bitrate, choose the preset marked with "Original bitrate ".
 
Bitrate – the bitrate reflects the amount of data in kilobits that is played back each second (measured in kbps). Higher bitrate usually means
higher audio quality as well as larger file size, as extra data needs to be stored within the file. For audio presets, the bitrate is listed next to
the format. When you convert a file to lower bitrate, the extra bits of data are irretrievably lost, meaning that you cannot increase quality by
converting audio to a higher bitrate, because the file no longer contains the data that can be used to restore higher quality.

 
Edit audio (optional)
Rename file
Renaming media files helps keep the music library in order.

1. 
 
Click the pencil icon   next to the file you want to rename.

2.  Enter the file's new name.
3.  Click OK.

 
Normalize and manage volume
If some of your music files are quieter than others, you can normalize their sound so you don't have to adjust the volume every time you
listen to them.
1.  Click the Edit button next to the file you want to normalize.
2.  The Editor window will open. There, switch to the Audio tab.
3.  Adjust the volume level or select the Normalize volume option.
4.  Click Save and Close.
Adjusting volume
 
Convert and upload
1.  At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous
folders by clicking the check near the Save to... button.

2. 
 
If you want to upload the music to iTunes after converting, click the sharing button  at the top of the window and select iTunes from

the pop-up window.
3.  When you're ready, click Convert to start the audio processing. Your files will be ready in a few minutes at most.
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Devices
Converting videos for devices such as smartphones and tablets is quick and easy: all you need to do is connect the device and the program
will suggest the recommended format and resolution for it.
 
Open files
Drag the files you want to convert onto the converter window.

Connect the device
Connect the smartphone or tablet to your computer using a USB cord.
 
Confirm the device
1.  Once the device is recognized, a dialog box will appear with the device name and the recommended preset. Check that the device name

matches your device. If the dialog box doesn't appear, click the Device Detection  button to the right of the search bar.
2.  If the device is correct, click Use These Settings to use the recommended output format, resolution, and other parameters.
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Several devices are listed
Sometimes, the device detection box shows a list of several devices. This can happen if you have more than one connected device, or with
some devices that are very similar and can't be identified precisely. In this case, open the Choose your device list and select the device
model that you want to convert for. Then, click Use These Settings to use the recommended format, resolution, and other settings. 
 
Device was not detected
•  If the dialog box does not appear, try clicking the Device Detection button to the right of the search bar.
•  Try reconnecting the device and wait for the system to detect it.
•  If that doesn't help, you can still find a preset for your device manually on the Devices tab.
 
The wrong device was detected
If the dialog box shows the wrong device, and that device isn't also connected to your computer, you can still find it manually on the Devices
tab of the preset list.

If you want to report this mistake, write to us at support@movavi.com and tell us your device model, and which device was shown instead.
 
Save and convert
1.  At the bottom of the window, click Save to... and choose a folder you to save converted files to. You can select one of your previous
folders by clicking the check near the Save to... button.
2.  Click the Convert button to start processing the videos.
3.  After conversion has finished, upload the videos to your device and enjoy.

mailto:support@movavi.com
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Disabling device detection
If you don't want to use device detection for any devices:
1.  Click the Settings button and choose Preferences.
2.  In the Preferences window, disable the "Recommend output format for connected devices" option.
3.  Click OK to apply the changes.

Disabling detection for one device
If you don't want the device detection window to appear whenever you connect a specific device:
1.  Connect the device and wait for the Device Detection window to appear.
2.  Select the "Don't show when I connect this device" option and close the window.
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Media streams
Every media file is made up of streams for each data type. A video can contain a video stream, a couple of audio streams, and several
subtitle streams. When converting files, you can find the information about these streams in two columns on the right. Here, you can manage
the streams that end up in the output file.

To get more details, right-click the file and choose File Information from the pop-up menu. Here, you can see all the information about the
original file's video and audio streams.
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Compress video
You can compress a video to reduce its output file size by sacrificing some of the quality. To do that, click the output file size and move the
slider to the necessary file size while keeping an eye on the quality.
Compressing videos
 
Choose audio tracks
If a file comes with a number of audio tracks for different languages, you can keep just the ones you need. To do that, click the audio stream
and deselect the audio tracks that you don't want to keep.
Choosing audio tracks
 
Choose a subtitle track
When you convert videos, you can permanently overlay subtitles on top of the video. To do that, click the subtitle stream and choose or add
the subtitle track that you want to use.
Choosing a subtitle track

Audio tracks
Choose audio tracks
In the rightmost column of the file list, click the audio track information box. The audio track list will appear. In the box with the audio tracks,
deselect the audio tracks that you don't want to appear in the output video. If you want to completely remove audio from the file, select the
No Audio option. You can remove audio from all the files in the list by checking the Apply to all files box. You can also apply an audio track
to all files.
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Note: not all formats support multiple audio tracks. The table below shows the maximum number of audio tracks for each format:
 

Format Number of audio tracks supported
3GP 1
AVI 16
DVD 8
FLV, SWF 1
MKV 16
MOV 16
MP4 16
MPEG-1, MPEG-2 16
OGV 1
WebM 16
WMV 16

Subtitle tracks
When you convert videos, you can permanently overlay any subtitle track onto the original video. This can be useful if you're watching videos
on a device, or your player doesn't support subtitles.
 
Choose a subtitle track
In the rightmost column of the file list, you can see the subtitle and audio track information for each file. Click the information next to the

subtitle balloon  to open the list of subtitles. In the subtitle list, click the subtitle track that you want to use.
 
You can choose soft or hard subtitles:
 
Softsubs are stored as a separate track and you can add several subtitle tracks to a single file. All the subtitle tracks will be saved if you
choose All subtitle tracks option. The option available when converting to MKV only, and you cannot edit this type of subtitles.

 
Hardsubs are permanently drawn on top of the video and cannot be turned off, but they are guaranteed to be visible in any player. Choose
subtitles you want to embed from the list. Before embedding, you can edit the subtitle track.
Learn more about editing subtitles

 
Adding subtitles
To add your own subtitles that aren't stored inside the original file, click the Add button above the subtitle list and then open the subtitle file
that you want to add. You can use *.srt, *.ass, *.smi, or *.ssa subtitle files. Or you can search for subtitles online.
Learn more about online subtitle search
 
Applying a subtitle track to all files
Choose a subtitle track and select Apply to all files. This function works only in case you have files with the same quantity of subtitle tracks,
for example, it is a series.

Online subtitle search
Open online subtitle search
In the rightmost column of the file list, you can see the subtitle and audio track information for each file.

1. 
 
Click the information next to the subtitle balloon  to open the list of subtitles.

2.  Click Add and then Search online...
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Search and download subtitles
1.  Type a movie or series title into the search field.
2.  Select a language you want to search subtitles for.
3.  Click Search.
4.  Choose a desired subtitle track in a list of search

results.
5.  Click Download and Add. The subtitles will appear in the list of subtitles.
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Check and embed subtitles
1.  You can check the subtitles by playing the file. Play and click After to see if it works right.
2.  If everything is okay, your next step is to embed the subtitles into the video so that they are visible in any player. Before you embed
subtitles, you can edit them.
Learn more about subtitle types | Learn more about editing subtitles

Extracting subtitles
1.  Click on the subtitles field next to the video you want to extract subtitles from.
•  Make sure to choose the video format.
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2. In the pop-up menu, click the Extract subtitles into a separate file button.
•  Now, the file with the extracted subtitles will be saved by default in Movavi Library folder.
•  The file will be automatically shown in folder at the end of the extracting process.

Editing media files
 

If you need to make some quick edits to the file before converting, click the Edit button next to the file that needs editing or Tools, and then
apply the necessary adjustments in the editing window.

Trimming videos
If you only want to convert a part of the video, you can trim off the parts you don't want from the beginning and end of the file.
Learn more about trimming videos
 

Original video - 5 min. Trimmed video - 30 sec.
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Joining videos
If your video footage is in several different files, you don't need to use a full-function video editor to join them together.
Learn more about joining files

Joined videos
Flipping and rotating videos
Nobody likes videos with the wrong orientation! This can be easily fixed with the Transform Video tool which lets you rotate and flip videos
or images.
Learn more about transforming videos

Left to right: original image, rotated 90° clockwise, rotated and flipped horizontally
Cropping videos
Cropping a video can change the video's aspect ratio to remove any black bars around it; you'll be able to use the entire screen when
watching the video. Cropping a video or image can also help to remove unwanted images from the edges of the screen (for example, if
there's a dumpster at the edge of an otherwise beautiful video!) or draw attention to the center of the frame.
Learn more about cropping

Cropping a video
 
Adding a watermark
Adding your name or logo on top of the video will make sure nobody else can take credit for your videos.
Learn more about watermarking

Original video; image watermark; text watermark.
Adjusting colors
Using Movavi Video Converter, you can make quick color adjustments to your videos and photos. Use automatic adjustments for fast
enhancement, or adjust the hue, brightness, and saturation manually.
Learn more about video adjustments

Before and after adjustment
Stabilizing video
If your videos have a lot of camera shake, you can reduce the effects using video stabilization.
Learn how to stabilize video

 
Adding effects
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You can add effects to your video! Video Converter has some simple effects as removing fish eye, sharpening, vignette, and more.
Learn how to add effects
 

Before and after effects
 

Enhancing audio
Many movies have problems with volume, where the dialogue is too quiet and action scenes blast at full volume. To combat this, you can
normalize the file's audio track using Movavi Video Converter, or adjust the volume level manually.
Learn more about audio enhancements

Trimming files
Enter edit mode
Click the Edit button next to your file and switch to the Trim tab. Here, you can trim your file or just split it into segments.

Cut out a part of the video:
1.  Move the position marker to the beginning of the segment and click the scissors button.
If you're trimming the file from the beginning or end, skip to the next step. You'll need a single cut for it.

2.   Move the position marker to the end of the segment and click the scissors button again.
3.  Click on the fragment to select it and click the trash can button to remove it.

4.  When you've removed all the parts you don't need, choose how you want to convert files. You can convert files as a single file, and the
segments will be merged, or you can convert them separately.
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5.  Then, click Save and Close to close the editing window.
 

You can also save each file of the list by clicking the floppy icon .
 
Cancel trimming
•  If you want to delete a cut marker, click a cross icon  near the marker.

• 
 
If you want to restore a deleted segment, click Restore  in the segment list.

•  If you want to go back to the original length, click Reset on the Trim tab in the editing window.
 
Precise positioning
To set a cut marker more precisely:
•  Click on a cut marker to select it and move it along the seek bar to change the cut position.
•  Click the Previous frame or Next frame button to move the position marker by exactly one frame.

Rotating video
Enter edit mode
Click the Edit button next to the file you want to rotate or select Rotate in the Tools tab.

Rotate or flip the file
1.  Click one of the buttons to rotate or flip the file. The rotation buttons will rotate the file by 90 degrees with each click.
2.  Click Apply to confirm the changes. If you want to rotate or flip all of the files in the same way, select the Apply to all files option.
3.  Finally, click Save and Close to close the editing window. Now, you can proceed to converting the files.
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Saving without conversion
 
You can rotate a file and save it without conversion. The Rotate without conversion option is available only for MP4, MOV, M4V-files with no
applied tools.
To do this, take the steps above to rotate a file and then click Save without conversion button.
When the saving finished, click Save and Close.

If you have any tools applied, click the broom icon and then Reset applied tools. The Save without conversion button will be available.
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Cropping video
Cropping a video can help you remove parts around the edges or fix the video's aspect ratio.
 
Enter edit mode
Click the Edit button next to the file you want to crop or select Crop in the Tools tab.

Crop your file
1. Drag the edges of the frame to change its size, and drag by the center of the frame to move it relative to the entire video.
•  If you want a specific size, enter it into the width and height boxes.
•  If you want to crop the video to a specific aspect ratio, make sure that the Maintain aspect ratio option is enabled and choose the
proportions from the box below.
 
2. Click Apply to accept the changes.
3. Click Save and Close to close the editing window, and then convert the files for the changes to take effect.

Adding a watermark
Use the watermarking tool to overlay any text or image over your videos and images.
 
Enter edit mode
Click the Edit button next to the file you want to apply a watermark to or select Watermark in the Tools tab.

Apply the watermark
Text watermark
1.  On the Watermark tab, click the Text button.
2.  Enter the watermark text into the box.
3.  Click the buttons under the text box to change the font, text color, and outline color.
4.  Move the Transparency slider to make the text more see-though.
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Image watermark
1.  On the Watermark tab, click the Image button.

2.  Click the folder icon  and choose the watermark image you want to use.
3.  Move the Transparency slider to make the image see-through and less distracting.
4.  By default, the image will keep its original proportions. To change the proportions, deselect the Maintain aspect ratio option.

 
Move the watermark
In the player, move the watermark to the necessary position.
1.  Drag at the corners to change the size of the watermark.
2.  Drag at the center to move the watermark.
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Exit edit mode
Click Apply to accept the changes. If you want to batch-process your files, select Apply to all files to apply the same watermark to other files
in the list.

Editing subtitles
 
Enter edit mode
Click the Edit button next to the file you want to overlay subtitles to or select Subtitles in the Tools tab.

Select subtitles
You can choose soft or hard subtitles.
Softsubs are stored as a separate track and you can add several subtitle tracks to one file. All the subtitle tracks will be saved if you choose
this option.
Note: Not all formats support softsubs. There are also less editing options: you can't change position and synchronize them with video. They
are also not displayed in the preview window.
 
Hardsubs are permanently drawn on top of the video and cannot be turned off, but they are guaranteed to be visible in any player.
 
•  If the subtitles are built into the file, select the necessary subtitles from the list.
If the subtitles are stored as an external file, click Add > Choose file... and open the subtitle file. You can use *.srt, *.ass, *.smi, or *.ssa
subtitle files. Or you can find them online.
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Set up the subtitles
 
Subtitle encoding
If the subtitle text looks scrambled, try changing the subtitle encoding: open the list and choose the language or character set the subtitles
should be in.
 
Position
Use the Position box to change where the subtitles appear on the screen:
1.  Open the Position box and choose which edge the subtitles should snap to (e.g. top or bottom).
2.  Use the slider below to move the subtitles relative to the selected position.
 
Synchronization
If the subtitles are out of sync with the video, use the synchronization box to advance or delay subtitles by a specific time in seconds and
milliseconds. Positive values make the subtitles appear later, and negative values make them appear earlier.
Example:
-0.100 – the subtitles will appear 100 milliseconds sooner.
1.200 – the subtitles will appear 1 second and 200 milliseconds later.

Edit the subtitle display
You can also change a font, its size and color, fill and outline. Find these settings under the selected subtitle track.

Exit edit mode
Click Apply and then Save and Close to apply the changes. When you convert the video, the selected subtitles will be permanently shown
over the video.

Adding effects
You can add effects to your video. There are seven simple effects in Movavi Video Converter.
 
Enter edit mode
Click the Edit button next to the file you want to apply effects to or select Effects in the Tools tab.
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Apply effects
1.  Click the preview icon to add an effect. You can apply several effects simultaneously.
2.  Click Apply to accept the changes. If you want to batch-process your files, select Apply to all files to apply the same effects to other files
in the list.
3.  Finally, click Save and Close to close the editing window.

Adjusting colors
 
Enter edit mode
Click the Edit button next to the file your file and switch to Adjustments tab or select Adjustments in the Tools tab.

Adjust the colors:
1.  Drag the sliders to change the brightness, contrast, hue, and saturation of the photo and video.
2.  Auto contrast option sets up brightness and contrast of a video or photo.
3.  Use the Magic Enhance option the automatically fix the brightness, contrast, and saturation of the video or photo.
4.  If the colors look unnatural, try the Auto white balance option.
 
Remove noise
1.  Move the Noise level slider to reflect the amount of noise you can see in the preview. The more noise you need to remove, the higher the
Noise level.
2.  Select the Noise removal option.
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Exit edit mode
1.  When you're satisfied with what you see in the preview, click Apply. To batch-process other files in the list with the same adjustments,
select Apply to all files.
2.  Finally, click Save and Close to close the editing window.

Adjusting audio
 

Enter edit mode
Click the Edit button next to the file your file and switch to the Audio tab or select Audio in the Tools tab.
 

Adjust the volume
1.  To change the volume of the whole file, drag the Volume slider to the necessary level, where 100% is the original volume.
2.  If parts of the file are too quiet, select the Normalize volume option to make them louder.
 
Remove noise
1.  Select the Remove noise option.
2.  Drag the Noise level slider to set the amount of noise you can hear in the file.

Exit edit mode
1.  When you're finished, click Apply to accept the changes. To fix the volume for all the files in the list, select Apply to all files.
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2.  If you don't need any further editing, click Save and Close to close the editing window.

Low volume detection
When you add files to the converter, it will check the volume of the files and recommend steps if the volume is too low.
 
Find low volume files
1.  The converter will mark quiet files with the "Low volume" tag. Click the tag to see the recommended course of action.
2.  A message will appear, recommending volume adjustment. Click Boost Volume in the message to open the audio adjustments.

Boost volume
The Normalize volume option will already be selected for you. Play the file to check the new volume level. If you need more volume
adjustment, use the Volume slider to set the necessary volume level. Click Apply once you're satisfied with the new volume.

When you're finished, click Save and Close to return to the main window.

Stabilizing video
Videos shot on handheld cameras often look shaky and unstable, no matter how hard you try to keep the camera level, especially if you're
filming sports using a portative action camera such as a GoPro®. To remove camera shake from your videos:
 
Enter edit mode
Click the Edit button next to the file your file and switch to the Stabilization tab or select Stabilization in the Tools tab.

Set up stabilization
Set up stabilization with the following parameters depending on the video and the amount of shaking:
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Accuracy: affects the analysis precision of the video. Higher accuracy yields the best results, but also takes more time.
Shaking: set how strongly the shaking is visible on the video.
If you need more advanced settings, click the arrow under the sliders.

Radius: when a video is stabilized, each object is adjusted using the pixels from the surrounding area. The radius affects how large that area
will be. Use a smaller value for more dynamic videos to avoid mixing objects together and to preserve more detail.
 
Smoothing: limits camera acceleration. Higher values work best for more or less static videos. Excessive smoothing may limit panning.
 
Edge Cropping: after compensating for motion, some distortion artefacts like blurred areas may appear around the edges.

•  None: the edges will remain as they are. Best results if there is little shaking on the video.
•  Fixed: the video is cropped to one size to cut off some of the edges.
•  Adaptive: whenever there is a lot of shaking, the video will zoom in so that the distorted edges are not shown.

Exit edit mode
1.  Click Apply to accept the changes. If you have several similar files, select Apply to all files to stabilize them in the same way.
2.  If you're finished editing the file, click Save and Close to go back to the main window. Stabilization will only take effect after you convert
the videos.

Uploading files to iTunes
Adding converted videos and music to your iTunes library will allow you to play them on any of your devices connected to the same iTunes
account.
 
Before you start
To upload files to iTunes, you will need iTunes 6.0 or higher installed on your computer.
Download iTunes
 
Prepare the files
1.  Open the files you want to convert.
2.  Choose an output format. Choosing output format
3.  Edit the files. Editing media files

https://www.apple.com/itunes/download/
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Choose iTunes uploading
1.  Click the the sharing button at the top of the window.
2.  Select iTunes from the pop-up list.

Convert files
Click Convert to start processing your files. After conversion is completed, the files will be uploaded to your iTunes cloud storage.

iTunes® is a trademark of Apple Inc.

Accelerating conversion
Here are some things you can do to convert videos even faster.
 
Take advantage of your hardware
Movavi Video Suite is optimized for the latest hardware, allowing you to use your computer's full potential when converting videos.
 
Enabling acceleration
To enable these acceleration options, click the Settings button in the converter window, and choose Preferences from the pop-up menu. In
the preferences, switch to the Acceleration tab and select the available acceleration options.

 
Learn more about SuperSpeed Learn more about NVIDIA acceleration Learn more about Intel acceleration Learn more about AMD acceleration

Intel HD Graphics is a trademark of Intel Corporation.
NVENC  is a trademark of NVIDIA Corporation.

SuperSpeed conversion



 

112

SuperSpeed mode allows you to convert video files much faster than usual without losing any quality. When you convert videos, encoding the
video from one codec to another takes the most time. If you don't need to change the video codec or resolution, the video data can simply be
copied to the new file, without having to convert it. This is also sometimes called remultiplexing or remuxing.
 
When can it be used?
SuperSpeed mode can be used any time when the video stream in the output file is the same as the original:
•  The output codec is the same as the video codec in the original file (e.g. when converting MKV files with the H.264 codec to MP4 files with
the H.264 codec)
•  The output resolution is the same as the original
•  No video adjustments are used. This includes stabilization, video adjustments, denoising, subtitles, watermark, crop, and rotation.
•  No video compression is used.
•  You can still enjoy SuperSpeed conversion when trimming files.
 
How to use SuperSpeed conversion
To use SuperSpeed conversion mode, choose output presets marked with the SuperSpeed badge:

This can be a video format or a device preset that has the same codec and resolution as your original files. 

Intel® Hardware acceleration
If you have one of the latest Intel processors, you can use the built-in graphics chip to accelerate conversion of H.264 and MPEG-2 video.
 
Intel hardware acceleration
•  Accelerates video processing by up to 400% when converting H.264 and MPEG-2 video codecs.
•  This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology.
•  When choosing an output format, look for presets marked with the Intel HD GRAPHICS badge.
 
Compatible processors
Intel hardware acceleration is available on Intel® Core™ i3, i5, and i7 processor series. For a full list of processors that support integrated
graphics, please consult the Intel support center.
 
How to use Intel acceleration
You can enjoy Intel acceleration when converting videos to H.264 and MPEG-2 codecs. When selecting an output format, choose formats
and presets marked with the Intel® HD GRAPHICS badge. Conversion to these output formats will be accelerated.

http://www.intel.com/content/www/us/en/support/processors/000005718.html
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Troubleshooting:
Can't enable Intel hardware acceleration
If the Intel hardware acceleration option in Movavi Video Converter preferences is unavailable:
•  Check that your processor is compatible with Intel hardware acceleration. To do that, open the Control Panel, go to System and
Maintenance, and choose System. Find the processor information and make sure that you have an i3, i5, or i7 Intel processor.
•  Update the Intel processor drivers. You can find the newest version at Intel's official website here. We recommend only downloading drivers
and other software from trusted sources.
•  In order for the graphics acceleration to work properly, there needs to be a monitor connected to the graphics card port. Connect the
monitor and make sure it is functioning properly, then try enabling Intel® hardware acceleration again.
 
Problems while converting using Intel® hardware acceleration
If the video conversion process is taking longer than expected, or there are defects in the output video file:
•  Try updating the processor drivers. You can find the newest version at Intel's official website here.
•  Try disabling Intel acceleration in the preferences.

Intel HD Graphics is a trademark of Intel Corporation.

NVIDIA® Hardware acceleration
If you have one of the latest NVIDIA® graphics cards, you can use its graphics processing power for converting videos. Using the graphics
card instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering while converting
videos.
 
Convert using NVIDIA GPU
•  With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50%
faster.
•  Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other
programs.
•  This option is only available if your computer is equipped with an NVIDIA graphics card that supports NVENC™.
•  When choosing an output format, look for presets marked with the NVIDIA NVENC badge, depending on the acceleration technology
supported by your graphics card.

Compatible graphics cards

https://downloadcenter.intel.com/default.aspx
https://downloadcenter.intel.com/default.aspx
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NVIDIA acceleration supports GeForce, Tesla and Quadro graphics card series. You can find the full list of supported GPUs on NVIDIA®'s
official site: NVIDIA NVENC supported GPUs
Note: NVIDIA acceleration does not support mobile graphics cards.
 
Troubleshooting
How do I find out which GPU my computer has?
1.  Right-click on your desktop and choose Display settings
In the Display settings window that appears, click Advanced display settings. This will open your GPU's properties.
 
The Enable NVIDIA GPU Acceleration option is unavailable
If you can't enable NVIDIA acceleration, try updating your graphics card drivers.
NVIDIA Download Center | Detailed Instructions
 
Problems while converting video with NVIDIA GPU acceleration
If the video conversion process is taking longer than expected, or there are defects in the output video file:
•  Try updating the graphics card driver. Detailed instructions
•  Try disabling NVIDIA GPU acceleration on the Acceleration tab of the preferences.

AMD Hardware acceleration
If you have one of the latest AMD graphics cards, you can use its graphics processing power for converting videos. Using the graphics card
instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering while converting videos.
 
AMD hardware acceleration
•  Accelerates video processing by up to 2,5x when converting to H.264 video codec for heavy files.
•  This option is only available if your computer is equipped with AMD graphics card that supports the Video Coding Engine technology.
•  When choosing an output format, look for presets marked with the AMD Video Coding Engine badge.

Compatible graphics cards
When using the H.264 codec, acceleration will work with graphics cards released after April 2014.
 
Troubleshooting
How do I find out which GPU my computer has?
1.  Right-click on your desktop and choose Display settings
2.  In the Display settings window that appears, click Advanced display settings. This will open your GPU's properties.
 
The Enable NVIDIA GPU Acceleration option is unavailable
If you can't enable NVIDIA acceleration, try updating your graphics card drivers.
AMD Driver Download Center | Detailed Instructions
 
Problems while converting video with AMD acceleration
If the video conversion process is taking longer than expected, or there are defects in the output video file:
•  Try updating the graphics card driver. Detailed instructions
•  Try disabling AMD acceleration on the Acceleration tab of the preferences.

Taking a snapshot
To save a single frame from the video:
1.  Click the Play button on the video's thumbnail in the list to view the original file.

https://developer.nvidia.com/video-encode-decode-gpu-support-matrix
http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download


 

115

 
2.  In the player window, move to the frame you want to save and click the Take a Snapshot button.

3.  A Explorer window will open. Choose where you want to save the snapshot and click Save.
The snapshot will be saved with the original video's size and quality.

Movavi Video Converter Settings and Preferences
To open the converter preferences, click the Settings button at the top of the window to open the settings menu. There, click Preferences.

 
The preferences are organized into tabs at the top: General, Conversion, and Acceleration. Click the related tab to find the preferences you
need.
General preferences
Conversion preferences
Acceleration preferences

General preferences
On the General tab of the preferences, you can choose the interface language and control how the application behaves.

 
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates within your version
are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.
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Send anonymous usage stats to Movavi – checking this box will allow the program to send usage statistics to our development team,
enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no
personal information, will not be disclosed to third parties and will be used for software improvement purposes only.
Learn more about how we use the statistics
Read our Privacy Policy
 
Recommend output format for connected devices – when you connect a smartphone or tablet, the program will detect the device and
recommend the optimal format for watching videos on it. Learn more
 
Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and you
see an error message when you start the program.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.
 
If the program works without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting
 

Conversion preferences
On the Conversion tab of the preferences, you can manage how files are converted.
 
Under Output file name, you can choose what happens if a file with the same name already exists in the output folder:
 
•  Overwrite existing file: the old file will be permanently replaced with the newly converted file.
•  Automatically rename files: new files will be automatically renamed, and both files will be preserved.
 
Under After conversion, you can choose what happens when conversion is finished:
 
•  Open output folder: shows the converted files in the output folder.
•  Play notification sound: the program will notify you when it has finished converting your files.

http://www.movavi.com/mip.html
http://www.movavi.com/privacy.html
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Acceleration preferences
On the Acceleration tab of the Preferences, you can accelerate conversion using the latest technologies. You can find out more about each
acceleration method in the Accelerating Conversion section.
 

Troubleshooting
If acceleration options are unavailable:
•  Your computer might not have the right hardware.
•  If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the
manufacturer's website: Intel Download Center | NVIDIA Driver Downloads

https://downloadcenter.intel.com/
http://www.nvidia.com/Download/index.aspx?lang=en-us
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Intel HD Graphics is a trademark of Intel Corporation.
NVENC and CUDA is a trademark of NVIDIA Corporation.

Record computer screen
With the screen capture program, you can record any part of your screen with audio and save the resulting video in any format you like.
Firstly, click Video on the Tools menu. Then click Launch on the Record computer screen tile to launch the screen capture program and
set up your capture preferences. If you want to start recording right away, click Start Recording on the Record computer screen tile. If
you launch the program for the first time, it will record full screen by default. If you have recorded something before, the program will start
recording the last selected area.

Don't know where to start?
Read these tutorials:

Recording screen
Capture any fragment of your

screen or the full desktop.

 Recording only audio
Record any sound from a device

or music on your computer.
Scheduling recordings

Record screen while
you're away from your PC.

Taking screenshots
Take, edit, and share

screenshots in a couple clicks.

How to open the capture module
To open the screen capture module:
 
From launch module
In the Movavi Video Suite launcher,  click Video on the Tools. Then click Launch on the Record computer screen tab to launch the screen
capture module. If you want to start recording right away, click Start Recording on the Record computer screen tab.

From Video Editor
If you want to add a captured video to your movie, click the Capture Screencast button on the Import tab in the video editing module. The
capture module will open. The recording will be added to your project in Video Editor right after you stop recording.
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Control panel
The compact control panel is the first thing you see when you launch Movavi Video Suite. The panel provides you with quick access to all
basic tools without blocking the content on your screen.
 
By default, the panel will be located at the right side of your screen, but you can pin it to any side you like.
Note that the panel cannot block the Windows taskbar (located below by system default).
 
 

Right border position (default) Upper border position Left border position
 

•  Click either of the camera buttons to start the area selection tool:  to take a screenshot,  to record screen.

•  Click the cogwheel button  to open Preferences.

•  Click  to hide the panel. Click  to show it again.

•  Clicking  will minimize the program to notification area. You can access the program from the notification area menu.

Recording video from screen
Launch Screen Recorder
1.  Open Movavi Video Suite and click Video on the Tools.
2.  Then click Launch on the Record computer screen tab to launch the screen capture module. Here you can set up the capture area.
3.  If you want to start recording right away, click Start Recording on the Record computer screen tab. If you launch the program for the first
time, it will record full screen by default. If you have recorded something before, the program will start recording the last selected area.
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Step 2: Set up the capture area
1. Click the camera  button on the control panel or press F10. The area selection tool will start.

2. Select the part of the screen that you want to record:
•  Click and drag on the screen to select the capture area.
•  To record a window or a window panel, hover your mouse pointer over it and click once a frame appears around it.
•  To record the full screen, press Space or click in any part of your screen (make sure no windows are selected!).
 
To adjust the area, use the orange markers on the frame to drag it or put the exact size in pixels on the panel above.

Step 3: Set up the sound and webcam
Note that recording system sound is only available in activated version.
By default, only the system sound recording is on. To enable webcam and microphone recording, click the corresponding icons:
 

  – Webcam off/on

  – Microphone audio recording off/on

  – System audio recording off/on
 
If you have more than one microphone connected, select the one you need from a list next to the mic icon.
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Step 4: Start recording
When you're ready to begin, click the REC button. You will be given a 3-second countdown before the recording begins.

Use these keyboard shortcuts to control the recording process:
F9 - pause the recording
F8 - take a snapshot of the capture area
F10 - end capture and save the recording
Tip: these are the default hotkeys. You can change them in the Keyboard Shortcuts section of the Preferences.
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When you're ready to finish your recording, click Stop on the recording panel or use the F10 keyboard shortcut .
 
Step 5: Edit the recording (optional)
When you finish recording, the capture editing window will open. Your video is ready and saved in MKV format, but you can preview it, edit, or
save it in a different format.
 
Cutting the recording
To cut out a fragment:
1. Place the position marker around the unwanted fragment and click the scissors icon.
2. Move the cut markers to adjust the fragment exactly as you want.
3. Click the trash can button.

Saving the edited recording
To save the trimmed version, or to change the format of your recording:
1. Click the Export button. The output options will open.
2. Choose a name and location for saving the video.
3. Choose a format for saving your video.
4. Click Save to start processing your recording.
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Frequently asked questions
I get a codec activation message when I try to start recording
When you first start using Movavi Video Suite, you need to activate the codecs you are using. Simply click Activate in the message box to
start using these codecs and continue with your capture. This process is free of charge and does not collect any personal information.

Record audio only
Besides screen activity, you can just as easily record online music, radio, podcasts, and voice input as standalone audio files.
 
Note that recording system sound is only available in activated version.
 
Step 1: Set up capture area
1. Click the camera  button on the control panel or press F10. The area selection tool will start.
2. If you need the video as well, select the area you want to record. If an audio file is all you need, select the smallest capture area possible
(16x16) in any part of your screen. This way, you will avoid taking up unnecessarily much disk space during recording.

Step 2: Set up the audio
On the recording panel, choose which audio sources you want to record from:

Recording system sounds
To record music, online videos, and any other sounds playing on your computer, click the system audio button.

off            on
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Recording microphone audio
To record sound from a microphone or any other recording device connected to your computer, click the microphone button. If you have
more than one recording device, click the arrow next to the button and select the device you want to record from.

off            on
Step 3: Record the audio
Click REC when you're ready to begin recording.

To end the recording, press F10 or click Stop  on the recording panel.
 
Step 4: Save audio file
When the recording is finished, the capture editor window will appear, where you can play the audio you've recorded.
 
1. Click Export to open the exporting options.
 
2. To save just the audio from your recording, open the list of formats and select MP3.
 
3. Click Save to turn your recording into an audio file.

Troubleshooting audio
My device is not available in the list.
If you don't see the device you want to use in the list, it may be disconnected or disabled in system settings.
 
1. Try re-connecting the device.
 
2. If that didn't help, right-click the sound icon in the Windows notification area and choose Recording Devices from the pop-up menu. The
Sound settings window will open.
 
3. Look for your device in the list:
•  If the device is working correctly, it should be marked with a green checkmark.



 

125

•  If you cannot find the device in the list, right-click anywhere in the list and make sure that the options Show Disabled Devices and Show
Disconnected Devices are selected.
•  If you still cannot find the device, download a driver for this device from the manufacturer's website and install it. This should help your
system detect the device.
 
4. Try enabling the device:
•  If the device is listed as Not Plugged In, try plugging in the device again.
If the device is listed as Disabled, right-click the device and choose Enable.

Mouse cursor effects
Using mouse effects, you can use the mouse as a pointer and show your viewers where to click. You can enable mouse cursor effects on the
effects panel:

By default, the cursor will be highlighted yellow and the mouse clicks red and blue for left and right mouse buttons respectively. However, you
can set up the effects the way you like.
 
Step 1: Open the mouse cursor options
1. On the control panel, click the cogwheel button  to open Preferences.
2. In the Preferences window, switch to the Effects tab.
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Step 2: Enable the cursor
Select Show cursor on recording. This will make the cursor visible on recordings. To make the cursor invisible, disable this option.

Step 3: Highlight cursor actions (optional) 
To make the cursor visible even better, you can highlight it or enable a special effect for clicks.
 
Highlight cursor
A semi-transparent circle will appear around the cursor, making it easier to track.
 
1. Select the Highlight cursor option.
 
2. (optional) The default highlight is yellow. To change the highlight color, click the square on the right and pick the new color.
 
3. (optional) Use the Size slider to make the highlight smaller or larger. The cursor itself will remain the standard size.
 
Hover your mouse over the square on the right to preview the highlight.

Highlight clicks
Concentric circles will appear for every click, color-coded for two mouse buttons. 
 
1. Select the Highlight clicks option.
 
2. (optional) Click the left square to set the color for the left mouse button.
 
3. (optional) Click the right square to set the color for the right mouse button.

Mouse click sound
A clicking sound will play whenever you click the mouse.
 
1. Enable the Mouse click sound option.
 
2. (optional) The default clicking sound has already been selected for you. If you want to use your own sound, open the drop-down box and
choose Add sound. Then, open the sound file that you want to use.
You can use WAV, MP3, AIFF, and AU files.
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Recording keystrokes
If you're making a tutorial that uses keyboard shortcuts, it's helpful to display them on screen for your viewers. Enable keystroke recording to
show the keys you pressed at the bottom of the video.

1. On the effects panel, click the keyboard button .
 
2. To enable keystroke recording, select one of the options:
•  All keystrokes — each key you press will appear on screen, including letters and numbers.
•  Keyboard shortcuts only — only key combinations such as Ctrl+C or Shift+Control+Esc will show up on screen. Letters and keys that do not
cause an action will not be displayed.  

To turn off keystroke recording, click the keyboard button again. 

Tips:
•  Avoid entering any passwords or other sensitive information while you're recording a video with keystroke recording: if you share the video,
your viewers will be able to see each character you type.
•  Keyboard shortcut recording does not work with the Windows key.

Scheduling
Any recording can be scheduled for a later time. You can use this to automate your recordings or capture late-night webinars.
 
Step 1: Set up your recording 
Scheduled recordings will start with the currently selected options (system sound, webcam, etc.) Before scheduling the recording:
 

1. (optional) Default capture area for scheduled recordings is full screen, so if you want to change it,  click the camera button  on the
control panel and select the part of the screen you want to see on your scheduled recording.
 

2. To enable system sound recording, click the speaker button  on the recording panel and make sure it is enabled and highlighted green.
 

Step 2: Schedule recording
1. On the control panel, click the cogwheel button  to open Preferences. Switch to the Scheduler tab.
2. Select Schedule recording.
3. Click the Add Task button.
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4. A task template will appear. Fill in the details for the task:
•  Title - the name of your recording
•  Date and time - the moment recording should start
•  Duration - how long the recording should last (e.g if you want to record an hour long webinar, set this at 01:00:00)
•  Capture area - by default, the program will record full screen. However, if you'd like to avoid recording extra parts of the screen, you can
select Current area. Be careful: the program will capture the area selected on screen at the moment your recording starts! If you don't select
the new area, last recorded area will be used.
•  After capture - you can set your computer to automatically sleep or shut down when the recording is over.

5. Click Create to add the task to your recording schedule.
 
Step 3: Enable launching at startup (optional)
The screen recorder needs to be running at the scheduled start time to begin the recording. If you've scheduled the recording for a later date,
enable the program to start with your computer so that you don't miss the recording. To do that, open the General section of the Preferences,
click More and enable the Launch application at startup option.
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Finally, click OK in the Preferences window to save the changes. After the recording is finished, the recording file will be stored in *.mscproj
format in the output folder with your other screen recordings.

Please note that if you haven't yet activated the program, the maximum capture time is 5 minutes for each video. To learn more about
activating Movavi Video Suite, see the Activating Software section.
 
If you are starting a lengthy recording, make sure that you have enough free disk space for saving the temporary recording files.

Time limit
When you record a long webinar or online video, you can limit the recording to a specific time and it will stop automatically once the time is
up. This way, you don't have to wait around for the video to end.
 

1. On the control panel, click the cogwheel button  to open Preferences. Switch to the Scheduler tab.
 
2. Select the Set time limit for recording option.
 
3. Set Duration by entering the time limit as hours:minutes:seconds.
 
4. Click OK to enable the time limit.
Note: the limit will work on all your next recordings in the current session only, until you restart the program.

5. Click the REC button on the recording panel to begin recording. After the specified time is up, the recording will end automatically.

Editing recordings
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When you end a recording, the player window will open, where you can view the finished video, save videos to a different format, and cut out
unwanted fragments.

Here's what you can do:
Cut recordings – trim videos from the beginning or the end, cut out fragments.
Navigate files – view and edit files from any folder.
Change recording format – save the video in a different video format, as an audio file, or even as an animated GIF.
Share recordings – publish your video online or send it to your friends and colleagues.

Opening the player
 
To open the capture player and editor, right-click the Movavi Screen Recorder icon in the notification area and select Preview Saved Files.

Also, the capture editor will open after you finish recording a video.

Navigating files
The right side of the player is dedicated to your media library. Here are some tips to use it to your advance:
 
•  The library contains all files you've captured with Movavi Video Suite, both videos and screenshots. To filter the files by type, click  and
select the file type you need to see now.
 
•  By default, the library shows files from the folder you have set for file recording on the Files tab in Preferences. If you wish, you can view

files from any other folder on your computer. Click  to select a different folder.
Note that Movavi Video Suite can only play files in *.mkv format. Other video files will not be shown in the library.
 

•  To enlarge the player window, you can hide the library by clicking  .
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Cutting recordings
This guide will show you how to cut out parts from video recordings using the built-in capture editor.
 
Step 1: Cut fragments
1. Move the position marker around the area you want to cut.
 
2. Click the scissors button. A fragment with two cut markers will appear at the current position.
 

Precise positioning
For more precise positioning, click on the cut marker on the seek bar and do any of the following:
•  Click the arrows next to the time to move the marker by a small interval.
•  With the cut marker selected, use the arrow keys to move it left or right by 100 milliseconds.
•  Manually enter the necessary time.
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Step 2: Delete fragments
1. On the seek bar, click a fragment to select it. The selected fragment appears as a darker shade.
 
2. To delete the selected fragment, click the trash can button above it.
 

A dotted line will appear on the seek bar where a fragment has been deleted: 

How to undo cutting

To cancel a cutting action, click Undo  or press Ctrl+Z. To repeat a cancelled action, click Redo  (Ctrl+Y). 
To exit the cut mode, click the scissors again.
 
Step 3: Save the edited video
If you've cut the video, you need to save it to apply the changes.
 
1. Click Export. The window with saving options will appear.
 
2. At the top of the window, choose where to save the file and enter a file name.
 
3. Choose a format for the video. If you don't know which format to choose, leave MP4 selected. It will save faster and at no quality loss.
 
4. Click Save to start processing the video. This may take a while for longer videos.

Changing the format
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New recordings are created in the MKV format which is supported by most players. This guide will show you how to save your video
recordings in a different format. You can also convert your video recordings to audio by saving them as an audio format.
 
Step 1: Open the output options
Click Export to open the output options.

 
Step 2: Choose a new format
Select a format you want to use:
•  Video - MP4, AVI, MOV, MKV
•  Image - GIF
•  Audio - MP3

 
Step 3: Save the file
Finally, click Save to convert your recording to the selected format. This may take a while for large videos.

Advanced settings
There are some extra settings you can use to customize your recorded files before saving. To open the settings, click Advanced in the saving
window.

Resolution
The frame size or resolution determines the videos width and height in pixels. Open the Resolution list to select from the most common
resolutions. Ideally, the frame size should not exceed the resolution of the recorded video, but match it instead. Smaller resolutions allow you
to make the output video smaller and thus save your disk space, however, this will sacrifice some video quality due to downscaling.
 
Framing
Choosing a resize method can help you manage how your video is resized to fit inside the frame size you've set. There are several resizing
options available:
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•  Smart fit... – scales the original video to fit the specified dimensions while maintaining the aspect ratio.
 
•  Up to size... – allows you to set a maximum frame size: input files with frame sizes exceeding the maximum are scaled down, while videos
with smaller frame sizes remain unchanged.
 
•  Letter Box – the video will be resized to fit inside the frame entirely. This method allows you to keep the whole video inside the frame
without distortions, but may place black bars around the video.

•  Stretch – the video is fit entirely inside the frame and then stretched on one axis in such a way as to fill the entire frame without leaving
black bars. This allows you to cover the entire frame, however, the objects in the video may appear horizontally or vertically distorted.

•  Crop – the video will be resized to be slightly larger than the frame, cropping the parts that do not fit inside it. This allows to cover the entire
area of the frame without distorting any of the objects inside the video or without leaving black bars, however, this may not suit some clips
where important objects are near the edge of the frame.

 
FPS
The number of frames per second is the number of shots that a camera takes each second to make a video. Most cameras shoot video at
around 24 frames per second. However, some cameras can shoot high-speed video that you can use to make slow motion clips. If you plan
on using high-speed videos, choose the FPS that matches the video. If you're using regular videos, leave the default FPS.
 
Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default
sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music
tracks.
 
Channels
Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording
music; mono sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally
preferred number of channels, however, some mobile devices record sound only in mono mode.

Sharing videos
For now, you can share your videos to YouTube, Google Drive, WhatsApp, Telegram, and our own cloud service – Movavi Cloud. You can also
start your mail client to send the file in an e-mail.
 
To share a recording:
1. In the library, select the recording you want to share.
2. On the bottom panel, select where you want to upload your video, then follow the selected service steps.
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Learn more about sharing to:
•  YouTube
•  Google Drive
•  Movavi Cloud

Uploading videos to YouTube
Once your video is ready, you can share it to YouTube!
 
1. Click Sign In and grant all requested access to allow Screen Recorder to upload files.
 
2. Fill in the details:
•  Give your video a title and fill in the description.
•  Add some tags to help users find videos by relevant topics. Separate tags with commas.
•  Choose a resolution that suits your video. For best results, choose a resolution that is equal to or less than the height of your video (e.g if
your video is 1280x720, choose the 720p resolution).
•  Choose a category to help viewers find relevant content.
•  Open the Privacy box and choose who you want to see the video.
Tip: if you want to save the video to your disk as well, check the Save to box and select file destination on your computer.
 
3. Click Start to begin uploading.

Uploading videos to Google Drive
You can use Google Drive to store your videos or share them with others.
 
1. Click Sign In and grant all requested access to allow Screen Recorder to upload files.
 
2. After you've signed in, the program will load your Google Drive folder list. You can share files to specific folders if you like. Select one of
them in the list.
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3. Fill in the details: title, privacy settings, the video format and quality.
Tip: if you want to save the image to your disk as well, check the Save to box and select file destination on your computer.
 
4. Click Start to begin uploading.

Uploading videos to Movavi Cloud
If you only need to quickly share a file, you can use Movavi Cloud – our own cloud service. It will give you a shareable link in just one click!
 

1. On the bottom panel, click the Movavi Cloud  icon. The upload will start immediately.
 

2. Share! The link will be copied to clipboard automatically, but you can also use the copy button or click View in Browser to open the file in
your default browser.

In the browser, you can play the video or download it. The file will be accessible by the link, so if you feel you might need to send it to
someone else some other time, make sure to know where to find it (e.g. in a message you've first attached it to).

Taking screenshots
Note that taking screenshots is only available in activated version.
 

1. On the control panel, click the screenshot button  .

2. Your cursor will turn into a crosshair. Select the part of the screen that you want to capture:
•  To capture a window or a window frame, hold your mouse pointer over the window and click after a frame appears around it.
•  To capture a part of the screen, hold the left mouse button and drag diagonally to draw a rectangle.
•  To capture the entire screen, click on any empty area of your desktop.
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3. A frame will appear over the selected area. You can now edit your screenshot:

•   Select a tool you want to add to your screenshot: Line  , Arrow , Frame  or Highlighter . Hold the left mouse button and drag to
draw a shape.

•   Change the color  and width  of your shape.

• 
 
 Drag by the green arrow circle or the white circles on the edges to resize the element; rotate by dragging the green circle left or right: 

•   If you need to move the capture area, click the Drag-area mode  button.
 

4. Choose what you want to do with your screenshot:

•  Click the Copy  button to copy the image to clipboard without saving the screenshot to a file.

•  Click the Save  button to save the image file and open its containing folder.

•  Click the Share  button to share the image to Movavi Cloud, WhatsApp, Telegram, and Google Drive or send it in an e-mail.

Where are the screenshots stored?
By default, the screenshots are stored in the "\Videos\Movavi Screen Recorder\" folder of your user. You can change where the files are
saved in the Files section of the Preferences.

Sharing screenshots
Note that taking screenshots is only available in activated version.
 

1. On the screenshot panel, click the Share  button.
 
2. Select where you want to share your image, then follow the selected service steps. It's that easy!
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Sharing screenshots to Google Drive
Uploading images to Google Drive will take you a couple extra moves.
 
1. Click Sign In and grant all requested access to allow Screen Recorder to upload files.
 
2. After you've signed in, the program will load your Google Drive folder list. You can share files to specific folders if you like. Select one of
them in the list.
 
3. Fill in the details: title, privacy settings, and the image format.
Tip: if you want to save the image to your disk as well, check the Save to box and select file destination on your computer.
 
4. Click Start to begin uploading your image.

Learn more: How uploading files to Movavi Cloud works

Screen Recorder preferences
 

To open the program settings for Movavi Screen Recorder, click the cogwheel button  on the control panel:
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The preferences window will open. The preferences are organized into eight categories: General, Files, Keyboard Shortcuts, Video, Webcam,
Effects, Scheduler and Sharing.

General preferences
The General tab allows you to change the basic behavior of the program. The settings are organized into two groups for your convenience.
 
Basic settings

 Disable countdown
Every time before the recording starts, you will see a 3-second countdown. This gives you time to prepare for your recording. Select this
option to turn the countdown off and start recording immediately.
 

 Hide recording panel
The recording panel appears when you start recording. It's semi transparent and it will not be recorded on top of your finished video even if
you record fullscreen, but you can hide it if necessary.

 Disable frame blinking during capture
In case the blinking irritates you, check this box. The frame will stay still during recording.
 

 Allow window panes selection
To record only the main window panes (no frames, menus or browser tabs), Movavi Screen Recorder needs access to your screen.

 
 Capture separate streams

When recording a video, the webcam, main onscreen video, external audio, etc. will be recorded as separate streams, like layers.
This can be useful for editing the video later, so you can edit them separately.
 

 Enable sound notifications
The program will notify you when a screenshot has been taken, a file export is finished, or if an error occurs.
 
Other settings
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 Launch application at startup

With this option enabled, Movavi Screen Recorder will start when you log in and run in the background. This way you will always be ready to
capture your screen.
 

 Use software OpenGL implementation (advanced)
This option can troubleshoot OpenGL problems for some graphics cards.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.
 

 Save extended logs for troubleshooting
In case you experience trouble using the program and contact our support team, they might ask you to collect logs. The logs contain the
program's actions for some period of time, as well as important error reports and descriptions. Extended logs give the most amount of
information which may be essential to solving your problem.
 

 Automatically check for updates
The program will notify you if a new version is available. Minor updates are absolutely free (for example, from v.1.3 to v.1.4). For major
updates users with purchased Movavi Video Suite license will get a considerable discount.
 

 I give consent to send anonymous usage stats to Movavi
Enabling this box will allow Movavi Video Suite to send us anonymous data about how you use the program. This data does not contain
any personally identifiable information and is only used for improving our software. You can find more information about how we use the
statistics on our Movavi Improvement Program page.
 

 Disable Aero theme during capture
Windows Aero themes that use transparency require more processing power. This may slow down your computer while recording video.
With this option enabled, the program will disable the Aero theme while recording to improve performance. The theme will be restored after
recording has finished.
(For Windows 7)
 

 Use DirectX for capturing
Try this option if you are experiencing problems capturing some program windows. In Windows 8 and above, the capture method is chosen
automatically and this option is unavailable.
(For Windows 7)
 

 Use alternative capture mode
If you get an error message when you start or stop recording your screen, try this option.
(For Windows 8 and above)

File preferences
In the Files section of the preferences, you can change where your captured files are stored. To change a folder location, click Browse and
select a new folder.

http://www.movavi.com/mip.html
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Record files to...
This is where all your captured files are saved automatically, both screenshots and video recordings. If you export the file, you can select a
different folder.
 

 Delete original recording after export
If you save the recording in a different format or trim the file, the original will be deleted.
 
Default screenshot format
Here you can change the format for all new screenshots. You can also change the format for a single screenshot by using the Save As button
in the editor window to save a copy with a different format.

Keyboard shortcuts
The Keyboard Shortcuts tab allows you to set your own custom shortcuts for such actions as starting or pausing the capturing process. On
the right, you can see keyboard shortcuts for every action.

To change one of the shortcuts:
 
1. Click inside the box with the shortcut you want to change. The box will become blank.
2. Simultaneously press on keyboard the keys you want to use as a shortcut to the selected action. The box will now display your custom
shortcut.
3. Click OK to apply the changes. To reset all the keyboard shortcuts to their original state, click the Reset to Default button.
 
If there's a keyboard shortcut you want to use in other software while Movavi Screen Recorder is running, check the  Disable keyboard
shortcuts box.
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In case you forget a shortcut, you can always look it up here in the keyboard shortcut settings.

Video preferences
On the Video tab, you can choose how the videos are recorded and saved, change the preferred audio quality, including the sample rate,
number of channels, and bits per second.

Frame rate
The frame rate defines how many frames will be captured each second and affects the smoothness of motion in the video. A lower frame
rate will result in smaller output size, however, the video may not turn out as smooth. The recommended frame rate is 20-30 frames per
second.
 
Sample rate
The first number is the audio sample rate, measured in Kilohertz (kHz). This is the number of digital samples taken each second to record
sound. Higher sample rate usually means higher quality. 44.1 kHz is the recommended sample rate, which corresponds to the human
hearing range.
 
Channels
Mono uses only one audio channel, which saves some disk space.
Stereo uses two audio channels, which allows distinguishing the direction a sound is coming from and usually sounds more natural.

 
Bit depth
Screen Recorder will record audio at 16 bits, which is the standard bit depth for most audio recordings. This means that every sample
contains 16 bits of information to encode sound.
 

 Enable SuperSpeed conversion
This option will make saving videos faster if you use the same output video codec. For example, if you cut the video without changing the
format. If you're having problems with saving some files, try disabling this option.
 

 Enable Intel hardware acceleration
This option will make saving videos faster if your computer is equipped with a compatible Intel® graphics chip. Intel acceleration works
when processing H.264, MP4, and MPEG-2 videos.
 

 Enable NVIDIA GPU acceleration
This option can make saving videos faster by using the graphics card to process media files. This leaves the CPU free for other tasks and
improves performance while saving videos. This option is only available if you have an NVIDIA® graphics card compatible with the NVENC®
or CUDA® technologies.  
 

 Enable AMD acceleration
This option is meant for the same purpose as the ones above: it allows to save videos faster, too, but this time you need an AMD graphics
card to use the acceleration.  

Webcam preferences
The Webcam section of the preferences allows you to set up your webcam for recording it on top of the main video. 
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Enabling the webcam
1. Connect the camera to your computer and wait until your system installs the necessary drivers.
2. In the Webcam preferences section, select the camera you want to use from the 'Use this webcam' box.
 
If the camera does not appear in the list, try manually installing the driver that came with your camera. You can use the preview square on the
right to check that the camera is working properly.
 
Webcam properties
Clicking the Settings button will open the camera's properties. These properties are different for each manufacturer, but generally you can
use them to calibrate the brightness, contrast, and exposure of your camera.
 
Resolution
The resolution affects the quality of the output video. If the video is very small, you can choose a lower resolution without a noticeable
decrease in quality.
 
Frame rate
Frame rate is the number of shots the camera takes each second. Higher frame rates will make the movements look smoother and work
best for videos with a lot of motion. If the picture is mostly static, you can decrease frame rate to save disk space. The standard frame rate is
20-30 frames per second.
 
Video size
Use the video size slider to set the size of the webcam overlay relative to the main video.
 
Position
Use one of the position options to choose where your webcam overlay will be placed on the original video.
 

Effects
In the Effects section of the preferences, you can set up the visibility of your mouse and keystrokes.
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Cursor options
Select  Show cursor on recording to make the cursor visible to your viewers.
 

 Highlight cursor
This option will add a bright circle around the mouse cursor to make it more visible.
1. Select the Highlight cursor option.
2. Click the square on the right to choose the highlight color. Use the Alpha channel box to change its opacity.
3. Use the size slider to change the size of the highlight circle.
Hint: hover your mouse over the preview square on the right to see how it will look on the recording.
 

 Highlight clicks
This option will flash a circle around the cursor for every click. You can set two different colors for the left and right mouse buttons.
1. Enable the Highlight clicks option.
2. Click the left square to set the color for the left mouse button.
3. Click the right square to set the color for the right mouse button.
 

 Mouse click sound
A clicking sound will be played every time you click the mouse to draw attention to your actions.
1. Enable the Mouse click sound option. The default mouse click sound will be used.
2. (optional) If you have a file with a different sound effect you want to use, open the box under ' Mouse click sound ' and choose Add sound.
Then, open the audio file with the sound effect. You can use WAV, MP3, AIFF, and AU files.
 
Keystroke recording options
•  Keyboard shortcuts only – only functional keys and key combinations (for example, Alt+Shift, or Ctrl+C) will appear on the video.
•  All keystrokes – all key presses, including letters of the alphabet, will appear on the video.
Hint: avoid entering passwords when this option is enabled if you don't want everyone to see your password.

Scheduler
In the Scheduler section of the preferences, you can start and stop recordings automatically.
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Automatically ending a recording
1. Select the "Set time limit for recording" option.
2. Enter the duration of the recording as hours: minutes: seconds.
Learn more: Time limit
 
Scheduling a recording
To start and end a recording automatically:
1. Select the "Schedule recording" option:
2. Click "Add Task" button.
3. Fill in the details and click Create to add your task to the recording schedule.
Learn more: Scheduling
 
The Screen Recorder application must be running at this time for the recording to begin. To make sure you don't miss it, enable the "Launch
application at startup" option in the General section.

Sharing preferences
The Sharing tab allows you to manage your YouTube and Google Drive accounts used to upload videos to.

To sign in to your account:
1. Click Sign In. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Screen Recorder upload videos.

Capture video
Follow the steps below to record video from a camera that's connected to your computer.
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Connect the camera
Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working
correctly.
 
Launch the video recording program
1.  Open the Movavi Video Suite launcher window, click Video on the Tools. Then click Launch on the Capture from cameras, VHS, TV tile.

2.  In the Video capture device box, choose the camera.
3.  Then, select the resolution and frame rate. A larger resolution will be able to retain better quality, however, the video file size will be larger.
A higher frame rate is necessary for recording motion, while static scenes can be captured with a lower frame rate.
4.  In the Audio capture device box, choose the microphone.

5.  Choose a destination folder. By default, the recordings will be saved to your Movavi Library folder. To change it, click the icon  near the
Save files to box.

6. 
 
Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera icon  on the right.
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Import AVCHD
Follow the steps below to import previously recorded videos from an AVCHD camera.
 
Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera. Make sure that
the system recognizes the device and that it is working correctly.
 
Step 2: Open the Movavi Video Suite launcher window and click Data on the Tools. Then click Launch on the Import AVCHD tab.

Step 3: In the Video capture device box, select your AVCHD camera.
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Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't need.

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere else, click the

folder button  under 'Save files to' and choose a different location. 
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file
name template. 
 
Step 7: Click Export files to start copying the files. This may take a while depending on the size of the videos.

Capture audio
Connect a microphone
Connect a microphone to your computer and make sure that it is recognized by the system.
 
Launch the audio recording module
Open the Movavi Video Suite launcher and click Audio on the Tools.
Then click Launch on the Record sound tab. The audio recording module will open in a separate window.
If you want to start recording right away, click Start Recording on the Record sound tab.

Set up audio capture
In the Audio capture device box, choose the microphone or whichever device you want to use for recording sound. To record audio that is
playing on your computer*, choose Stereo Mix or Speakers.
 
In the Saving captured files section, you can choose a template for naming the captured files. To do that, open the File renaming box and
choose date or free text. Then, fill in the template details and the recordings will all be named after this template.
 
Under Save files to, specify the folder where you want to save the recordings. Click the folder icon next to the box to browse for the folder
you need.
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Record
Click Start Capture to begin recording. As you record sound, you can see the frequencies reflected as color bars in the center. When you're
done, click Stop Capture. If you need to record more audio clips, simply repeat this step.
 
The audio files will be saved to the folder specified in the Save files to box. To open this folder, click the View saved files button. 

*Depending on the model of your audio card, this option may be named differently. Some device manufacturers do not include a system
audio recording option.

Split video
Split Movie is a lightweight program for quick video editing. With it, you can cut a video file into small scenes or cut out any number of
unwanted parts like commercials. To open the video splitter, click Video on the Tools of the Movavi Video Suite launcher. Then click Launch
on the Split video tab.

1.  Open a video
To open a video file, simply drag it onto the Split Movie window.
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Learn more: Open videos
 
2.  Edit the file
Use the Scissors button to cut the video into scenes, then select the scenes you want to remove and click the trash can button.
Learn more: Trim from the edges | Split scenes | Cut out parts
 
3.  Save the result
In the bottom right-hand corner, choose As separate files to save each scene to its own file, or choose As a single file to save the entire
video minus the deleted scenes to one file. Then, click Save and select where you'd like to place the new file(s).
Learn more: Saving the result

How to split video
The splitting module allows you to quickly split a video file into parts or cut out fragments without reconverting the file or any quality loss.
 
Launch the splitter
To open the video splitter click Video on the Tools of the Movavi Video Suite launcher. Then click Launch on the Split video tab.

Open files
To start cutting videos, click Open file in the middle of the window and choose a video file.
Learn more: Opening files

Split scenes
To cut the video into several scenes, place the position marker where you want to cut scenes and click the scissors  button. Repeat this
for all scenes in the video.
Learn more: Splitting scenes
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Cut out unwanted fragments
To remove a fragment from the video, place the position marker onto the beginning of the fragment and click the scissors  button. Then,

do the same for the end of the fragment. When the fragment is separated, select it and click the trash can  button to remove it.
Learn more: Cutting out parts

Save the result
In the bottom right-hand corner, you can choose how to save the resulting clips:
•  To save each scene as a separate file, select As separate files.
•  To save all scenes to a single file without the deleted fragments, select As a single file.
Then, click Save to start processing the video.
Learn more: Saving the result

Opening files
To open videos, do any of the following:
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•  Find a file in Explorer and drag it onto the Movavi Split Movie window.
•  Click Open file in the center of the window and choose the file.
•  Open the File menu and choose Open File. Then, choose the file you want to cut.

 
 
 

Playback
After you've opened the video, you can use the playback tools to find where you need to cut the video.
 
How to position the playback marker:
•  When you play the video, press the spacebar to stop the video when you see a scene border.
•  Use the Previous frame / Next frame buttons on the toolbar to move the position marker by one frame.
•  Use the timeline scale above the seek bar for reference.

Jumping to a specific time:
1. Open the Playback menu and choose Jump To.
2. Enter the exact time and click OK.
The position marker will move to the specified time.  

Cut out parts
Follow these steps to cut out an unwanted fragment from the video:
 
Step 1: Move the position marker to the beginning of the unwanted fragment.
 
Step 2: Click the scissors button.
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Step 3: Move the position marker to the end of the unwanted fragment.
 
Step 4: Click the scissors button again. The fragment is now separated from the rest of the video.

Step 5: Click the fragment you've cut to select it and click the trash can button to reject it.

Repeat these steps for all other unwanted fragments in the video. After you're done, don't forget to save the result.
 
See also:
Opening files
Saving the result

Liking a scene
You can quickly mark fragments as you play back the video.
 
Like a fragment – Press L to play the video and keep the fragments you pass.
 
Dislike a fragment – Press K to play the video and reject the fragments you pass. 

You can change these keys in the Keyboard Shortcuts window.

Using the brackets
Using the bracket buttons, you can mark the beginning and end of each scene. Using the brackets works best if you only need to keep a
small part of the video.

 The Left Bracket marks the beginning of a clip, rejecting the parts before it.

 The Right Bracket marks the end of a clip, rejecting the parts after it.
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Trimming from the ends
To trim the video from the beginning or from the end, click on the seek bar and pull on the markers on the edges:

Splitting clips
Step 1: Move the position marker to the beginning or the end of a fragment.
 
Step 2: Click the scissors button to make a cut.
 
Repeat this for other fragments that you want to cut into separate files. After you're done, don't forget to save the result.

See also:
Opening files
Saving the result

Editing clips
After you've cut the video into clips, you can edit each clip for more precise splitting.
 
Editing clips
To change the left and right borders of a clip, do any of the following:
•  Click on a clip and drag the white markers on its edges to change its length.
•  Click on a marker and press the left or right arrow keys to move it by exactly one frame.
•  To move a clip, select it and drag it by the center.

Setting exact time
In the Resulting clips column on the right, the exact beginning and end time is listed for each clip. Click the time and manually enter the new
time into the box.

Discarding clips
To discard an entire clip, select it on the Timeline on in the Resulting clips column and click the trash can button.

Merging clips
To merge two or more clips into one contiguous clip:
1. Select the clips you want to merge on the Timeline or in the Resulting clips column. Hold Ctrl to select multiple clips.



 

155

2. Right-click on the clips and select Merge from the pop-up menu. All of the selected clips (as well as any rejected fragments between them)
will be marked as one single clip.

Inverting clip selection
Open the Edit menu and select Invert clips in the pop-up menu. This will invert the selection for the entire file, meaning that previously
rejected fragments will be saved, and selected parts will be rejected.

Resetting clip selection
If you want to start over, click the Reset button on the toolbar or right-click in the Resulting clips section and select Delete All.

Saving the result
After you've split the scenes and removed unwanted fragments, you'll need to save the resulting clips. The saving options are located in the
bottom right-hand corner of the window.
 
Step 1: Select how you want to save the file
•  If you want to cut the video into several files, select As separate files.
•  If you want to save the video as a single file without the rejected parts, select As a single file.
 
Step 2: Click Save.

Step 3: You may be asked to choose a folder for saving the video. Click the folder icon  in the dialog box to change the folder. Click OK to
start saving the resulting clips.
Hint: If you want to keep using this folder, choose Always save to this folder without asking. You can always change this option on the Saving
tab of the Preferences.
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Keyboard shortcuts
For faster editing, the most commonly used actions are bound to shortcuts or hotkeys.
 
To open the list of shortcuts:
1. Open the Settings menu.
2. Select Keyboard Shortcuts.
 
To change a shortcut:
1. Double-click the field next to the action you want.
2. Press the key or key combination you want to use.
 
Note that some key combinations may not work because if they are used by your system.

List of keyboard shortcuts
 
 

Splitter preferences
To open preferences, go to the Settings menu. The options are sorted into two tabs at the top.
 
General
Language – Changes the interface language.
 
Automatically check for updates – Whenever a new version is available, you will be notified when you start the program.
 
Send anonymous usage stats to Movavi – Lets the program collect statistics about how you use the program. The data does not contain
any personally identifiable information and is only used for improving our software. You can find more information about how we use the
statistics on our Movavi Improvement Program page.
 
Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and you
see an error message when you start the program.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.
 
If Movavi Split Movie runs without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting

http://www.movavi.com/mip.html


 

157

Saving
Destination folder – this is where the resulting files will be saved by default. To change the location, click the folder icon  on the right.
 
Always save to this folder without asking – if this option is disabled, you will be prompted to choose a folder every time you save videos.
 
Play notification sound when splitting is finished – a sound will play when the resulting clips have been saved.

 

Play video and audio
With the Movavi Video Suite player, you can play video and audio in any format without having to install any additional codecs or software.
To open the player, click Video on the Tools of the Movavi Video Suite launcher. Then click Launch on the Watch video tab.

Or click Audio on the Tools. Then click Launch on the Play music tab.
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Opening files
To open video or audio files, click the buttons in the bottom right, under the playlist.
+ File to open individual files
+ Folder to open all the files in a folder
+ DVD to select a disc with videos. You will need to find the VIDEO_TS folder on the disc.
 
Or you can simply drag any files you want to play right onto the player window.

Playback
Basic playback buttons

Skipping frames

On the toolbar, click Skip forward  or Skip backward  buttons to skip 10 seconds forward or backward.
 
Playlist buttons
 
The playlist displays your media queue. If you want to jump to another item, double-click it in the playlist to play.

To show or hide the playlist, click the List button  on the toolbar.

To play all items in random order, click the Shuffle button .
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To play the same item again and again, click the Repeat button .
 
 
 

Adjust video
In Movavi Video Suite, you can adjust brightness, contrast, hue and saturation of the video.
 
Step 1: Open Video Adjustments dialog box
Click the Adjust video button on the toolbar.

The Adjust video button
Step 2: Adjust video
Hold your mouse on the markers and drag them left or right, depending on the changes you want to make. Release the markers to see how
your video has changed.

If you are satisfied with the results, click Apply to save your settings.

Change audio track
In Movavi Video Suite, when you watch a video with two or more audio tracks, you can easily switch between them.
 
In the menu, click Audio and select Audio Track in the pop-up menu. A list of available audio tracks will appear. Select the one you need. You
will hear it immediately.

Subtitles
Changing subtitles track
In the menu, click Subtitles and select Subtitle Track in the pop-up menu. A list of available subtitle tracks will appear. Select the one you
need. You will see it on screen immediately.

To load subtitles from a file, select Add Subtitle File on the list.
 

Subtitle timing
You can adjust your subtitle timing in case you notice it's off track. In the menu, click Subtitles and select Synchronize Subtitles in the pop-
up menu. A list of options will appear. Select the one you need. (For example, clicking +5 seconds will make subtitles appear on screen 5
seconds later than before).
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Subtitles positioning
To move subtitles, click Subtitles in the menu and select Align Subtitles in the pop-up menu. A list of positioning options will appear. To set
subtitles to a certain part of the screen, choose Top ... Right. Clicking Move up ... Move right will slightly move subtitles around the screen.

Add to Favorites
 
You can add the features you use most frequently to the Favorites board.
 
Open available features
1.  Open the Movavi Video Suite launcher.
2.  Click the Plus icon on the Favorites board.

Add to the Favorites board
1.  Select one or several features.
2.  Click OK to add features to the Favorites board.
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Burn files to disk
With the Burn Disc application you can burn videos to DVDs, create audio CDs, copy discs and burn any kinds of data to a CD, DVD or Blu-ray.

How-to's:
Burn videos to DVD
Burn an audio CD
Burn data to disc

Burn ISO image to disc
Copy disc to disc

Rip disc to hard drive
 

Step 1: Add Files
1. In the Video tab of the Movavi Video Suite launcher, click Burn CD, DVD, Blu-ray to open the Burner module. The ChilIBurner module will
open.
2. Drag and drop the files you want to burn from Windows Explorer onto the ChilIBurner window to add them to the disc queue.
 
Step 2: Choose Disk Type
1. In the Mode section on the right, choose the type of disc that you have. Disc type and capacity should be printed somewhere on the disk
itself or on its packaging.
2. Then, choose video options for the selected disc type.
 

NTSC or PAL – select the TV standard depending on the DVD player you have or the country you live in.
•  NTSC is used in North and Central America, most countries of South America (excluding Argentina and Brazil), Burma, Japan,
the Philippines, South Korea, Taiwan, and Vietnam.
•  PAL is used in all countries of Africa, Europe, Oceania, and the Middle East, most Asian countries, as well as in Argentina,
Brazil, Paraguay, Uruguay, and French Guiana
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Quality – this parameter affects video and audio bitrate. Higher quality requires more disc space.
 
Aspect ratio – the ratio between the width and height of the video's frame. 4:3 is the standard format used for TV, while 16:9 is used
for widescreen movies.

 
Disc type – select DVD if you have a regular DVD disc, or DVD DL if you have a double-layer DVD (it should be written somewhere on
the package your DVD came with).
 
DVD menu template – select a graphic DVD menu, which is the first thing you see when you open a disc on your player, and where you
can select which file to play. 

 

Step 3: Burn Disc
1. Check the disc capacity scale at the bottom. If the blue line crosses into the red, it means that there is not enough space to fit all of the
added files. In that case, you can either set a lower quality, or write some of the files to another disc.

Disc capacity scale
 

2. In the upper right-hand corner of the window, enter a name for the disc. It will show up in My Computer when you view all your drives.
3. Make sure that a writable disc of the selected type is inserted into the drive, and your hardware supports disc writing. 
4. Click Burn Disc to begin recording the files to disc. This may take a few minutes.

Burn a video DVD
Step 1: Open the Burn Disc application in Video mode
1. Click Burn disc on the Data tab of the Movavi Video Suite launcher app.
2. The Burn Disc application will open. There, click on the Video tab at the top.
 
Step 2: Choose your disc type
In the Mode section of the right-hand column, choose DVD mode.

Step 3: Add the files you want to burn
•  Drag-and-drop files onto the ChilIBurner window, or

•  In the bottom left-hand corner, click the plus icon  to add a file, or the folder icon  to add the contents of one or more folders to the list.
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Step 4: Set up your disc preferences
Set the following preferences in the right-hand part of the window:
 

Disc name – located at the very top of the panel. You will see this as the name of the disc drive when you insert the DVD into your computer
or DVD player.
NTSC or PAL – select the TV standard depending on the DVD player you have or the country you live in.
•  NTSC is used in North and Central America, most countries of South America (excluding Argentina and Brazil), Burma, Japan, the
Philippines, South Korea, Taiwan, and Vietnam.
•  PAL is used in all countries of Africa, Europe, Oceania, and the Middle East, most Asian countries, as well as in Argentina, Brazil, Paraguay,
Uruguay, and French Guiana
 
Quality – this parameter affects video and audio bitrate. Higher quality requires more disc space.
Aspect ratio – the ratio between the width and height of the video's frame. 4:3 is the standard format used for TV, while 16:9 is used for
widescreen movies.

 
Disc type – select DVD if you have a regular DVD disc, or DVD DL if you have a double-layer DVD (it should be written somewhere on the
package your DVD came with).
DVD menu template – the DVD menu is the first thing you see when you open a disc on your player, and where you can select which file
to play. The ChilIBurner module allows you to select and customize professional-looking DVD menus. By default, only one theme will be
available, but you can select Download More Themes from the list and download additional themes from our official website. If you want to
customize or preview the selected theme, click Edit. You will see the following window:

Here, you can set the time for the previews of each video and change the music that will play in the menu. Click OK to apply the changes.
 
Step 5: Burn disc
At the bottom of the ChilIBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill when you
record the videos, while the yellow and red lines display the maximum capacity of the selected disc type.
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Make sure that you have not exceeded the disc capacity. To free up some space, you can delete files from the list or slightly reduce quality.
Then, check that you have a writable DVD in your DVD drive and click the Burn Disc button to begin the burning process. Your disc will be
ready in a few minutes.

 

Burn an audio CD
Step 1: Open the Burn Disc application in Audio mode
Click Burn audio to CD on the Audio tab of the Movavi Video Suite launcher app.
 
Step 2: Choose audio disc type
In the Mode section of the right-hand column, choose Audio CD or MP3 CD mode. Standard audio CDs usually fit about an album's length of
music, but can retain quality very well, while MP3 CDs allow you to record several folders of audio files to one CD. Please note that not all CD
players support MP3.
 
Step 3: Add the files you want to burn
•  Drag-and-drop files onto the ChilIBurner window, or

•  In the bottom left-hand corner, click the plus icon  to add a file, or the folder icon  to add the contents of one or more folders to the list.
 
Step 4: Set up your disc preferences
On the right panel of the ChilIBurner interface, set the following preferences:
 

Disc name – located at the very top of the panel. You will see this as the name of the disc drive when you insert the disc into your computer
or Blu-ray player.
 
Disc type – select CD if you have a regular CD Disc, or Mini-CD if you have a CD of smaller size (8 cm or 3.1 inches in diameter versus the
standard 12 cm or 4.7 inch CDs).
 
Quality – if you select MP3 CD mode, you can set the quality of the audio files. Higher quality files have higher bitrate, but take up more
space. If you select Audio CD mode, the best quality will automatically be selected. 
 
Step 5: Burn disc
At the bottom of the ChilIBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill when you
record the videos, while the yellow and red lines display the maximum capacity of the selected disc type.

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete files from the list or slightly reduce quality
for MP3 files.
Then, check that you have a writable CD in your disc drive and click the Burn Disc button to begin the burning process. Your disc will be ready
in a few minutes.
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Burn data to disc
Step 1: Open the Burn Disc application in Data mode
Open the Movavi Video Suite launcher application and click Burn disc on the Data tab.

 
Step 2: Add the files you want to burn
•  Drag-and-drop files onto the ChilIBurner window, or

•  In the bottom left-hand corner, click the plus icon  to add a file, or the folder icon  to add the contents of one or more folders to the list.
 
Step 3: Set up your disc preferences
On the right panel of the ChilIBurner interface, set the following preferences:
 

Disc name – located at the very top of the panel. You will see this as the name of the disc drive when you insert the DVD into your computer
or DVD player.

 
Disc type – select the type of recordable disc that you have. Disc capacity is listed in parentheses. If you are not sure if you have a double-
layer (DL) DVD or Blu-ray™ disc, check the package that it came with. 
 
Step 4: Burn disc
At the bottom of the ChilIBurner window, there is a disc capacity scale. The blue line reflects how much of the disc you will fill when you
record the videos, while the yellow and red lines display the maximum capacity of the selected disc type.

Make sure that you have not exceeded the disc capacity. To free up some space, you can delete some files from the list or, if you are
recording video and audio files, use the conversion module to compress them.
Then, check that you have a writable disc of the selected type in your drive and click the Burn Disc button to begin the burning process. Your
disc will be ready in a few minutes.

Please make sure your optical drive supports recording to the selected type of disc.

Burn ISO to disc
The Burn Disc module can help you burn disc images with the .iso extension to an optical disc.
 
Step 1: Open the Burn Disc application in Copy mode
1. Open the Movavi Video Suite launcher and click Burn image to disc on the Data tab.
2. In the Burn Disc application, open the Copy tab.

 
Step 2: Select the image
Click the Browse icon  next to the Source list to browse for the .iso file you want to burn.
In the Destination list, select the drive you want to use for recording. If you have only one DVD-RW drive, it will be selected automatically.
 
Step 3: Start burning
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Check that you have a writable disc in the optical drive and click Burn Disc to begin burning your ISO file to disc.

Copy disc to disc
If you have two CD/DVD drives:
Step 1: Insert the discs
Insert the disc you want to copy into one of the drives. If only one of your CD/DVD drives can burn discs of this type, insert the disc into the
read-only drive (i.e. CD-R or DVD-R drive).
Then, insert a recordable disc into the other CD/DVD-RW drive. If you are using a CD/DVD-R disc, make sure that is hasn't already been
recorded to.
Please note that Movavi Video Suite is not intended to make illegal copies of copyrighted software. Some CDs and DVDs may be copy-protected and cannot be copied or
ripped to hard drive.
 
Step 2: Open the Burn Disc application in Copy mode
Open the Movavi Video Suite launcher and click Copy disc to disc on the Data tab.
 
Step 3: Set Source and Destination
In the Source list, select the drive with the disc you want to copy. If you cannot see the drive in the list, make sure that the CD/DVD you want

to rip is inserted into the drive and click the orange refresh icon  to its right.
In the Destination list, select the drive with the empty disc.
 
Step 4: Start copying
Click Burn Disc to begin copying data from one disc to another.

If you only have one CD/DVD-RW drive:
1. Save the contents of the disc as an ISO.
2. Burn the ISO file to disc.
 

Copy disc to hard drive
Step 1: Insert the disc
Please note that Movavi Video Suite is not intended to make illegal copies of copyrighted software. Some CDs and DVDs may be copy-
protected and cannot be copied or ripped to hard drive.
 
Step 2: Open the Burn Disc module in Copy Disc mode
Open the Movavi Video Suite launcher application. In the Data tab, select Copy disc to hard drive. The Burn Disc module will open.
 
Step 3: Set Source and Destination
In the Source list, select your CD/DVD drive If you cannot see the drive in the list, make sure that the CD/DVD you want to rip is inserted into

the drive and click the orange refresh icon  to its right.
In the Destination list, select Browse folder and specify the location where you want to save the disc files.
 
Step 4: Start copying
Check that you have enough disc space to copy the disc and click Burn Disc to begin copying disc files to your hard drive.

 

Help and support
Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.

How to reach us
By e-mail: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!
 
If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information
about your system will allow us to help you faster.

Frequently asked questions:
How to remove trial restrictions?
Why do my videos have "trial version" on them
What are the system requirements for running Movavi Video Suite?
How to update the graphics card drivers?

System requirements
  Minimum system requirements Recommended configuration

mailto:support@movavi.com
https://www.movavi.com/support/contact.html
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Operating system Windows® 7/8/10 with latest service packs and patches
Processor Intel, AMD or compatible processor, 1.5

GHz
Intel, AMD or compatible processor, 2.8 GHz
and above

Graphics card NVIDIA® GeForce™ series 6 or higher, AMD Radeon™ R600 or higher graphics card with up-
to-date drivers*

Resolution 1280x768, 32-bit color 1280x1024 or higher
RAM 2 GB 4 GB
Available disk space 830 MB for installation

2 GB for ongoing operations**
10 GB

  Administrator permissions are required for installation
Additional features:   Sound card for audio recording and playback
    Intel® hardware acceleration requires a

compatible Intel processor supporting Intel HD
Graphics™ 2nd generation or higher
Learn more

    For intended performance, make sure that your
graphics card drivers are up-to-date.
Updating graphics card drivers

 
* Your graphics card must support OpenGL for the program to run correctly.
** Free disk space is required to save the temporary recording file and the output video. The required amount of disk space will depend on
the resolution, format, and length of your videos.
 
Movavi Video Suite may also run on slower machines, however, we cannot guarantee stable performance if the minimum requirements are
not met.

Supported formats
 

 
Video formats Input Output

 
Supported codecs

3GPP (.3gp), 3GPP2 (.3g2) H.263, H.264, MPEG-4
ASF (.asf)   MPEG-4, VC-1, WMV V7

H.264, MPEG-4, MJPEGAVI (.avi)
  DivX, Xvid, DV, Cinepack, Fraps, TechSmith, Uncompressed

DivX Video (.divx)   DivX

DVD  

FLV1, H.264
  VP6, H.263, Flash Screen Video

Flash (.flv, .swf)

  MJPEG
H.264, MPEG-4, MJPEG, Theora, VP9Matroska (.mkv)

  DV, Uncompressed
MPEG Transport Stream (.m2ts) MPEG-2, H.264
MPEG Transport Stream (.ts, .mts, .m2t)   MPEG-2, H.264
MPEG (.mpg, .vob) MPEG-1, MPEG-2
MPEG (.mpeg, .mpe, .m1v, .dat, .mod, .tod, .vro)   MPEG-1, MPEG-2, H.264

MPEG-4, H.264MPEG-4 (.mp4)
  H.263, MJPEG, ProRes

MPEG-4 (.m4v)   MPEG-4, H.264, H.263, MJPEG, ProRes
MXF – Material eXchange Format (.mxf)   MPEG-2, DV

TheoraOGV – Ogg Video (.ogv)
  MPEG-4

H.264, MPEG-4, MJPEGQuickTime (.mov)
  AIC, ProRes, Sorenson 1/3, PNG

QuickTime (.qt)   H.264, MPEG-4, AIC, MJPEG, ProRes, Sorenson 1/3
RM (.rm, .rmvb)   Real Video 2/3/4, Cooker

VP8, VP9WebM (.webm)
  VP7

WMV V8WMV – Windows Media Video (.wmv)
  WMV V7, WMV 9, WMV 9 Screen, WMV 9 Advanced profile, MPEG-4,

WMV 9.1 Image V2
WTV (.wtv)   H.264, MPEG-2

 
Audio formats Input Output

 
Supported codecs

AAC – Advanced Audio Coding (.aac) AAC
AIFF (.aif,.aiff)   AIFF
APE – Monkey's Audio (.ape)   Monkey's Audio

program_preferences.htm#video_preferences
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Au (.au, .snd)   WAV
FLAC – Free Lossless Audio Codec (.flac) FLAC
MP3 – MPEG-1/2 Audio Layer III (.mp3) MP3
MPEG-4 (.m4a) AAC, ALAC
MPEG-4 ( .m4b)   AAC, PCM
Opus (.opus)   Opus
OGG – Ogg Audio (.ogg) Vorbis

PCMWAV – Waveform Audio File Format (.wav)
  AAC, MP3

WMA – Windows Media Audio (.wma) WMA 9
    WMA Pro, WMA Voice

Image formats Input Output  
APNG (.apng)    
BMP (.bmp)  
DPX (.dpx)    
GIF (.gif)  
JPEG (.jpg)  
JPEG (.jpeg, .jpg, .jp2, .jls)    
Netpbm formats (.pgm, .pbm, .ppm, .pam)    
PCX (.pcx)    
PNG (.png)  
PTX (.ptx)    
SGI (.sgi)    
TARGA (.tga)    
TIFF (.tiff)  
WebP (.webp)    
XBM (.xbm)    
XWD (.xwd)    
 

Updating graphics card drivers
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics
card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a
driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance
of applications and games on your computer.
 
Step 1: Find your graphics card manufacturer
1.  Right-click your desktop and choose Screen Resolution
2.  In the Screen Resolution settings window, click Advanced settings.
3.  This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type
section. Note the full name of the graphics card somewhere for later.
 
Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There,
look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility
that will automatically find the necessary driver.
NVIDIA download center
AMD download center
 

Warning:
Only download drivers from the official manufacturer's website. Third-

party websites offering driver downloads may contain malware.
 
Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the onscreen instructions to install the driver on your system. Your
display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.
 

 
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows
you to optimize your computer's graphics performance.
 
1.  Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please
try the method above.
2.  In the Drivers section, click the Check for updates button to find the latest drivers.
3.  When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and
install the necessary driver for your system.

http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download
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Updating AMD® or ATI® Driver
 
1.  If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
 
2.  Download the auto detect utility and run it when the download has finished. 
Download Auto Detect Utility
 
3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads
page and download the driver.
 
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
5. After the driver has been installed, it is recommended that you restart your computer.
 

If none of the above steps have helped, feel free to contact our support team via e-mail support@movavi.com or live chat.
 
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have
encountered. This will help our support team specialists solve your problem quicker.
 
 

OpenGL troubleshooting
If you see the following message about OpenGL when you open Movavi Video Suite, your computer most likely does not support the
necessary version of OpenGL. To run Movavi Video Suite, your computer needs to support at least OpenGL version 2.0, and version 2.1 is
required for smooth performance.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:
 
Step 1: Update your graphics card driver
Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver
installation file from the manufacturer's website and install it following the on-screen instructions.
Detailed instructions on updating the driver
 
It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Video Suite. If you see an error
message again, proceed to the next step.
 
Step 2: Try the software OpenGL implementation
If your graphics card still doesn't support OpenGL 2.1 even after updating the driver, you can use a software alternative:
 
In the message you see after starting Movavi Video Suite, select the Download and install software OpenGL implementation box.
 
Or, in the main Movavi Video Suite window, open the Settings menu and choose Preferences. There, select the Use software OpenGL
implementation option and click OK.

http://support.amd.com/en-us/download
http://www2.ati.com/drivers/auto/autodetectutility.exe
mailto:support@movavi.com
https://chatserver.comm100.com/ChatWindow.aspx?planId=1190&visitType=1&byHref=1&partnerId=-1&siteid=27345
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After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi
Video Suite.
 
If these steps haven't helped:
•  Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.
•  Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem.

Hardware acceleration
Movavi Video Suite is optimized for the latest Intel®, NVIDIA®, and AMD hardware acceleration technologies.
 
Intel acceleration
Movavi Video Suite supports hardware acceleration provided by Intel® multi-core processors and integrated graphics, which allows for faster
encoding/decoding, as well as simultaneous conversion of a large number of files by employing the full power of each core. Performance
grows up to 400% for H.264 and MPEG-2 codecs and up to 8 files can be processed simultaneously.
 
Supported Formats
Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec; MPEG (MPEG2 PS, MPEG2 TS) with MPEG1/MPEG2 codec;
WMV with VC-1 codec.
Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec; M2TS, MPEG with MPEG2 codec.
 
NVIDIA acceleration
If your computer is equipped with an NVIDIA® graphics card, you can use it to accelerate media file processing up to 5x by shifting a part
of the workload to the graphics processing unit, freeing up your computer's CPU for other tasks. This technology supports the newest
NVIDIA® graphics cards, including GeForce™, GeForce Mobile, Quadro, and Quadro Mobile. You can find the full list of supported GPUs on
our webpage.
 
Supported Formats:
Input Video Formats: AVI, MP4, FLV, MKV, MOV, MPEG2-TS with H.264 codec, MPEG (MPEG2 PS, MPEG2 TS) with MPEG1/MPEG2 codec,
WMV with VC-1 codec.
Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec.
 
AMD acceleration
If your computer is equipped with an AMD graphics card, you can use it to accelerate media file processing up to 2,5x, especially for heavy
files (2K & 4K).
Output Video Formats: 3GP, 3GP2, AVI, FLV, M2TS, MKV, MP4 with H.264 codec. MP4, MOV, MKV, M2TS with H.265 codec.
 
Enabling hardware acceleration
To enable Intel or NVIDIA acceleration in Screen Capture, or Video Converter: 
1.  Open the Settings menu and select Preferences.
2.  In the Preferences window, select the acceleration method that is compatible with your computer.
3.  Click OK to accept the changes.
 
To enable Intel or NVIDIA acceleration in the Video Editor:
1.  Open the Edit menu and select Preferences.
2.  In the Preferences window, switch to the Acceleration tab.
3.  Select the acceleration method that you prefer. For Intel® acceleration, you can choose hardware or software acceleration methods for
each of the supported codecs.
4.  Click OK to accept the changes.
 

Troubleshooting
If the acceleration option is unavailable it may mean one of the following:
•  Your computer is not equipped with the right hardware
•  The driver may be out of date or not installed.
Intel Download Center
Updating graphics card drivers

https://www.movavi.com/support/contact.html
http://www.movavi.com/videoeditor/performance.html
http://www.movavi.com/videoeditor/performance.html
https://downloadcenter.intel.com/
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